NUTS
NMR Data Processing
Software

for
Microsoft Windows 3.1, Windows-95/98/2K, Windows NT and Macintosh

Acorn NMR Inc.

7670 Las Positas Rd.
Livermore, CA 94550
Telephone: (925) 456-1020
FAX: (925) 456-1024
Email: info@acornnmr.com
http://www.acornnmr.com

1

Contents
INTRODUCTION

3

HELP ON NUTS

3

GETTING STARTED WITH NUTS

3

ZOOM SUBROUTINE

7

PHASING

8

Importing data
Using the Mouse
Base Level Operation
Vertical Scaling
Cursor
Plotting
Cut and Paste to the Windows Clipboard

5
5
6
6
6
7
7

BASELINE CORRECTION

10

INTEGRATION

11

PEAK PICKING

13

INSET PLOTS, CHEMICAL STRUCTURES AND COMPANY LOGOS

15

INSET PLOTS (IS SUBROUTINE)

16

TEXT ANNOTATION (NO SUBROUTINE)

16

ADD/SUBTRACT

17

BUFFERS (BU SUBROUTINE)

18

LINE FITTING

18

NMR SIMULATION

20

LINKED COMMAND LISTS FOR AUTOMATION OF PROCESSING

23

MACROS

23

AUTOMATED MATH CALCULATIONS

24

DISPLAYING RELAXATION DATA AND CALCULATING T1 AND T2

27

2D PROCESSING

29

ARRAYED MODE 2D OPTION

31

SEARCHABLE ARCHIVE OPTION

32

ALPHABETICAL COMMAND LIST

34

DATA TRANSLATION

40

TECHNICAL SUPPORT

41

ACORN NMR SOFTWARE LICENSE AGREEMENT AND SUPPORT POLICY

42

2

NUTS
NMR Data Processing Software
Introduction
NUTS is an NMR data processing program for IBM-compatible PCs running Windows and Macintoshes
(PowerPC versions), available as Lite, 1D, 2D and Professional versions. NUTS is normally distributed electronically. Download the appropriate .zip or .sea file from http://www.acornnmr.com. Upon
purchase, a license file is sent via email, with instructions for installation.
Separate versions are available for Windows 3.11 (no longer being updated) and for Windows 95/98/
NT/2K. For Windows 3.11, additional files are required; see installation instructions below.
Many parameters used by NUTS are set each time the program is started according to values specified in
a file called nuts.ini. This is an ASCII file which can be edited with any text editor, and allows each
user to customize the program. The file contains extensive comments describing each parameter. It is
suggested that users read through this file and acquaint themselves with the options it provides.
NUTS operates with data in the Common Data File Format. NUTS will automatically identify the origin
of most files and the Import command performs the format translation automatically. A complete description of the file format, the type of files supported for translation and the details of the translation
process can be found in the on-line Help under Data Translation and CDFF. New file formats are being
added to NUTS as sample files and format information become available.
To minimize size, the installation file contains only 2 sample files. Others can be found at
http://www.acornnmr.com/sample_data_files.htm.

Help on NUTS
Note that the most up-to-date documentation is found on the web site,
http://www.acornnmr.com/NutsHelp
The NUTS Help file for Win95/98/NT has been converted to the new HTML Help format. The functionality of this compiled HTML Help file is provided by ActiveX, Microsoft's implementation of Java.
That means that the Help file can only be used with Win95/98/2K or NT 4. Also, it requires Internet
Explorer 3.01 or later and some system files installed on your computer during the NUTS installation.
See http://www.acornnmr.com/NutsHelp/help_files.htm for details. MacNUTS users, and Windows
users whose computers are not equipped to handle the HTML Help files, should use the Help files at
http://www.acornnmr.com/NutsHelp

Getting Started with NUTS

This section gives an overview of NUTS procedures for new users. It covers how to navigate around
the program and perform common processing functions. It is strongly suggested that new users read
at least through the section on Peak Picking (through page 15). Experience has shown that the
descriptions will make more sense if you have NUTS open while reading, and try out the operations as
you read. For simplicity, not every command is covered. For complete command descriptions, please
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see NUTS Help or the HTML Help files at http://www.acornnmr.com/NutsHelp. Also, a complete
alphabetical list of commands begins on page 32. Note that not all features described are available in
all versions of NUTS.
Users are encouraged to explore the Help files, which provide step-by-step instructions for NUTS
operations and are illustrated with screen captures. Use the Help file within NUTS (Win95/98/NT/2K)
or http://www.acornnmr.com/NUTSHelp.
The NUTS program is typical of most Windows and Mac programs in operation of the menu system and
the GUI (graphical user interface) environment. By selecting from the choices displayed in successive
layers of menus, the user can access most of the basic features of the program. It is assumed that the user
is familiar with common operations.
In addition to menus, a command line user interface is also active. With a few exceptions, all commands
can be executed from the command line. In the default mode, commands are 2-letter commands, executed immediately, without requiring a carriage return (Enter). When the menus are pulled down with
the mouse and the choices displayed, the keyboard letters corresponding to each command are also
shown. This learn as you go approach allows the user interested in operation of NUTS from the
command line to become familiar with the necessary commands in the course of normal operation and
minimizes the frustrations of searching through manuals. Again, On-line Help is also available.
Keep an eye on what is displayed on the command line at the bottom of the screen. When a single
character is typed, it appears on the command line and NUTS waits for a second character before
executing an operation. If a character is accidentally typed, and then a 2-letter command is entered (via
keyboard or menus), NUTS will pair the accidentally typed character with the first character of the
intended 2-letter command. NUTS will then attempt to execute a command that was not intended. If
this combination of characters is not a valid command, NUTS will respond by typing a question mark
and do nothing. In the event a character is typed by mistake, typing <Enter> or <backspace> will abort
that character and clear the command line. In short, watch for orphan characters on the command line.
A new command mode has been added which allows for longer commands. In this mode, <ENTER> is
required to execute each command. The default command mode is set in the nuts.ini file. The command
mode can be set in NUTS with the commands 2N and 2F, which turn on and off the 2-letter mode,
respectively. The reasons for the new command mode are a shortage of logical 2-letter command names
and a need for increased flexibility. Some long commands allow an argument to be supplied on the
command line. Details of this command mode can be found at http://www.acornnmr.com/NutsHelp/
longer_commands.htm.
The status bar at the bottom of the screen displays helpful messages, such as noting when the user has
entered a subroutine and explanation of menu items selected with the cursor.
NUTS consists of a base level of operation and several subroutines (phasing, integration, Zoom
expansion, line fitting, spectral simulation, etc.). Commands within a subroutine are single-letter commands, executed as typed. The menu choices will change to reflect the options which are appropriate
in each subroutine. The name of each subroutine or Base Level is indicated in the gray status bar at the
bottom of the NUTS window. In some cases, the cursor also changes as a cue that the user is in a
subroutine. In a few cases, there are subroutines within a subroutine (e.g., it is possible to enter the
Integration subroutine directly from the NUTS base level or from within the Zoom subroutine). In all
cases, typing <Enter> will exit the subroutine.
An UnDo command has been added. This works only for operations performed in the Base Level of
NUTS, not in subroutines. A copy of the data is saved after each operation. This takes the form of a
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stack, similar to an RPN calculator, which has 10 entries. If the user wishes to revert to an earlier
copy, the Ctrl-Z command will replace the current data with the previous copy. The stack will roll
down. Repeating Ctrl-Z will repeat this action, and the stack rolls down again. UnDo does not work in
Links and Macros. It will work for 2D processing in Arrayed Mode, but this may cause excessive
reduction in processing speed, so is not recommended. UnDo can be turned on and off using the commands UN and UF, respectively, and its default setting is specified in the nuts.ini file.
Importing data
Translation, or import filters, for most types of files from major spectrometer manufacturers are included with NUTS, for both FIDs and transformed spectra. A list can be found in the File/Import menu,
but this may not be up to date. The ability to identify the origin of most data files has been built into
NUTS, based on unique attributes of each file type. It is usually best to select Auto Detect (keyboard
command IM) when importing a file, and let the NUTS program identify the file type and apply the
appropriate translation. A message appears on the screen during the translation process, to let the user
know what NUTS has determined the file type to be.
Once the file has been translated, it is displayed on the screen. At the top of the window is displayed the
file name of the data set, referred to herein as the current data file. Note that NUTS has appended a $
to the name of the original file. This allows the file to be a unique name, while retaining a connection to
the original file name. The translated data is saved to disk at the time the translation is performed.
The Windows version of NUTS keeps track of 2 different paths, identifying the directory that it will read
data from and write data to. The first of these is referred to as the data directory, and is used by the
File/Open (GA) and File/Save (SA) commands. If a file is read from or saved to a different directory,
that new directory becomes the current data directory, and files will now be read from and written to the
new location. The second directory that NUTS keeps track of is referred to as the import directory
and is used by the File/Import (IM) command. The purpose of a second path is to allow a user to import
data from, for example, a remote archive location, then save the data to a local disk, without having to
repeatedly select the path. It is important to understand what operations change the data path, as the user
can inadvertently save data to a directory that was not intended. The current paths for these 2 directories
can be displayed with the WP (Which Path) command, allowing the user to keep track of where NUTS is
reading data from and writing data to. Note that the Macintosh does not handle path names in the same
manner, and always uses whatever folder was last accessed by NUTS.
Using the Mouse
NUTS relies on extensive use of the mouse to give the user maximum ability to interact with the
data. The mouse is used differently in different parts of the program because the tasks to be performed are not always the same. The left mouse button is primarily used, but some operations make
use of both buttons. Users with a single-button mouse must hold down the shift key and press
the mouse button to perform those functions assigned to the right mouse button. If there is a 3button mouse, the middle button functions as the <Enter> key. (This assumes that the user has not
specifically configured his/her mouse buttons differently.) The different mouse operations and
examples of their use are:
Single click of the left mouse button -- menu selections
Double click of the left mouse button -- enter Zoom subroutine for expansion of a spectrum
Press and hold the left mouse button and move the mouse -- In base level: real-time read out of
the cursor location (displayed in lower right corner). In Zoom: select a frequency region
Single click of the right mouse button -- In Zoom: toggle display between full and expanded frequency range
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Double click of the right mouse button -- In base level: toggles between the full and expanded
display
Press and hold the left mouse, then click the right mouse button -- set a marker cursor for difference mode for cursor frequency read out; users with a single button mouse can press the period
key on the keyboard in place of the right mouse button.
This may seem confusing at first, but pointing to features in a spectrum is such an integral part of
working with data that the advantages soon become apparent.
Base Level Operation
When the NUTS program is started, it is in the base level of operation. Many functions of NUTS (such
as Zoom and Integration) operate as subroutines of the base level, and these will be discussed separately. The cursor is displayed as an arrow when in the base level of NUTS. In some cases, upon entry
into a subroutine, the cursor will change to remind the user what routine is in use and the status bar at the
bottom of the screen indicates the subroutine. The menu choices also change.
As a learning tool, sample files are supplied with the NUTS distribution disk. It is recommended that
new users open these files and practice the routine operations of NUTS described herein. (Note, not all
commands are provided in the following descriptions. However, a complete command list, along with
brief descriptions, is included on page 32. For complete command descriptions refer to NUTS Help or
the HTML Help pages at http://www.acornnmr.com/NutsHelp). To open a file, either type GA from the
keyboard or choose File/Open from the menu to bring up a dialog box, then choose a file using the dialog
box.
Vertical Scaling
The first spectrum will automatically be scaled to display the tallest peak at full height. Vertical scaling
can be done by using the scroll bar on the right, with the <, > (greater-than and less-than keys), or
the PAGE UP and PAGE DOWN keys. At any time, the vertical scale can be reset to zero with S0 or the
largest displayed peak can be made full height with Ctrl-Y. Vertical scaling can be done in subroutines
as well as the base level. Use NUTS Help (search for Scaling the Spectrum Display) or the section on
scaling in the HTML Help files for a complete description of commands which affect scaling. Note that these
commands affect display of the data only; the actual values of the data points are not affected.
Cursor
In the base level of NUTS, a mouse cursor (arrow) will show on the display which moves as the mouse
moves. If the left mouse button is depressed and held, a full window crosshair will replace the mouse
cursor and its x and y position is displayed in real time in the lower right corner of the window as the
mouse is moved. The x position is shown as data point number, Hertz and PPM. The vertical position
is shown as a percent of the tallest peak in the spectrum. This information is displayed as long as the
mouse button is depressed. This cursor can also be used to set the chemical shift reference, as follows.
With the left mouse button depressed, place the cursor on a peak of known chemical shift and type O.
A dialog box appears allowing the user to set the current x position of the cursor to a given frequency or
PPM. In this same dialog box, you can also choose whether or not NUTS will employ interpolation for
both setting the shift reference and for peak picking operation, and whether or not NUTS should snap
to a local maximum when the reference is set.
Displaying the cursor information in difference mode is also an option. While continuously holding
down the left mouse button, place the crosshair on the desired location of the spectrum and click once
with the right mouse button. (Users with a single button mouse can press the period key on the
keyboard in place of the right mouse button.) This sets a marker cursor with a vertical cursor, and an
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additional line of readout will be displayed at the bottom right of the window. This additional line of
display shows, in real time, the current cursor x position relative to the marked position. As the mouse
is moved (still holding down left mouse button), this difference display is updated. This is useful for
quickly measuring coupling constants, line widths, etc. All functions return to the default base state of
operation when the left mouse button is released.
Plotting
The currently displayed spectral region is plotted, as it appears on the screen, by typing PL or by
choosing the File/Print menu selection. Spectral parameters will be plotted at the bottom of the page.
These parameters are spaced expecting a Landscape 8.5 x 11 plot. Thus, be sure the printer is in the
landscape mode before printing (with the printer dialog box). Again the printed spectrum will have the
same characteristics as the displayed spectrum (spectrum height, axis type, integral display). In addition, there is a Page Setup option under the File menu which allows several plot features to be set.
Cut and Paste to the Clipboard
The currently displayed spectrum can be placed in the clipboard using the Edit/Copy menu option or
Ctrl-C. From the clipboard, it can be placed into other programs, such as word processing programs for
inclusion in reports. The picture is a bit map and the result will have the best quality if the NUTS
window is set to the size desired for the final figure before the Edit/Copy operation is performed. This
will avoid the need to resize the figure in the target application, which can cause distortions. NUTS also
provides the option of copying the spectrum as one of several types of Metafile (PICT file on the
Macintosh), which are vector-type drawings rather than bitmaps, and result in a better quality picture. In
the Windows version, metafiles can also be written to a file on the disk. NUTS now supports 3 different
metafile formats: standard, placeable and enhanced. (Win 3.11 does not support enhanced metafiles.)
Multiple options are available because other applications may support only one type.
For more detailed information, search for Copying to Reports in the NUTS Help or http://
www.acornnmr.com/NutsHelp.

Zoom Subroutine

The Zoom subroutine allows the user to expand a spectrum horizontally to view details. That is, one
can zoom in and out. (This is similar to the GE/Nicolet Zoom subroutine and the Bruker EP subroutine.) There are several ways to enter the Zoom subroutine of NUTS: type ZO from the keyboard,
select Zoom from the View menu, or double click the left mouse button. To exit, type <Enter>.
On entering the Zoom subroutine, the menu choices change to display commands which are currently
active, the mouse cursor changes from an arrow to a small crosshair labeled ZO, and the gray status bar
at the bottom of the screen indicates Zoom. All commands can be accessed with single letter codes
or from the menus, with the exception of mouse operations.
To expand a region in Zoom, press and hold the left mouse button, and drag the mouse across a
region of the spectrum. This region will now be highlighted in inverse video (usually red). To jump to
this expanded display, type Ctrl-E or click the right mouse button. (Users with a single-button mouse,
hold the shift key down and then press the mouse button whenever instructions call for the right mouse
button.) The right mouse button toggles between the full and expanded displays. Ctrl-F will return to
the full display as well. While viewing an expanded region, the left mouse button can be used to select
a still smaller region, and Ctrl-E or the right mouse button can be used to jump to this new expansion
(Zoom within Zoom).
There is a horizontal scroll bar at the bottom of the screen which allows the user to pan across the
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spectrum. Moving along the scroll bar changes the frequency limits defining the expansion, but not the
size of the expanded region. This scroll bar is active whether or not the program is in the Zoom
subroutine. (Obviously, if the full spectrum is displayed, moving the scroll bar will not change anything.) Alternatively, a specific frequency range of interest can be entered from within Zoom by typing
F (also available from the Display menu), which brings up a dialog box for entry of frequency limits in
points, Hz or ppm. After closing the dialog box, Ctrl-E sets the display to the chosen limits. Upon
exiting Zoom to the base level, the currently expanded region remains displayed (use Ctrl-F or double
click the right mouse button to return to the full display).
A word of explanation regarding using the mouse within the Zoom subroutine: Because a frequency
region is selected by holding down the left mouse button and moving the mouse, a single click of the
mouse button will result in defining an expanded region which consists of only one point. Upon expansion, the screen will appear blank. This is easily corrected by returning to full display (Ctrl-F or right
mouse button) and re-selecting the desired region.
ZO Subcommands Include (Commands available from menus):
B: Baseline flatten by removing the DC level and linear tilt within the zoom limits. (See Baseline Correction.)
D: Tilt right-hand end of spectrum down. The amount of tilt is determined by either upper or lower
case letter  lower case d makes small changes, upper case D makes larger changes
F: (set frequency limits) Brings up a dialog box allowing entry of specific points or frequency limits for the
expanded display.
I: Enter the integral (ID) subroutine (see Integration). <Enter> will return to Zoom from the ID
subroutine.
U: Tilt right-hand end of spectrum up. The amount of tilt is determined by either upper or lower
case letter  lower case u makes small changes, upper case U makes larger changes
Ctrl-Z: (zero zoom region) Zero the data (both real and imaginary points) within the expanded
region.
1: (set PE region 1) Select current Zoom region for region 1 in PE phasing routine (see Phasing).
2: (set PE region 2) Select current Zoom region for region 2 in PE phasing routine (see Phasing).
Some 2-letter commands also operate within Zoom in the same manner as in the base level:
SZ: Set the tallest peak in the expanded region to 0 PPM/Hz.
PL: Print the displayed region.
For more information search for Zoom in NUTS Help or at http://www.acornnmr.com/NutsHelp.

Phasing

There are several ways to phase a spectrum with NUTS. Often, optimal phasing is achieved using a
combination of phasing routines.
Auto Phase
The first way is to use one of two automatic phasing options: QP (Quick Phase) or AP (Auto Phase).
Both commands adjust the zero- and first-order phase corrections to obtain the maximum value for the
sum of the real points, but use different algorithms. QP is faster and usually works fairly well for
proton spectra, while AP is slower and gives good results on carbon spectra. There is also an automatic
phase command (QA) which adjusts the zero-order phase only. These routines work best if there is a lot
of baseline (no peaks) at the ends of the spectrum, there is no DC offset for the spectrum and the baseline
is reasonably good. If the phase obtained is not perfect using the automatic routines, manual phase
adjustment becomes necessary.
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Manual Phase
There are three different ways to phase a spectrum manually, PH (Phasing by Mouse), PE (Phasing
Expanded), and PC (Phase Correction). PH allows mouse phasing with the entire spectrum (or expanded region) displayed. PE allows careful mouse adjustments of phase using an expanded display.
Finally, PC applies numerically entered phase values and is probably the least easy to use. For users
with a single-button mouse, when instructions call for use of the right mouse button, hold down the
shift key and then press the mouse button.
To adjust the spectrum phase using the mouse, type PH or select Process/Phasing by Mouse from the
menu. After entering this phasing routine a reduced data point display of the data will be shown,
allowing real-time display updating in response to mouse movements. When the left mouse button is
depressed, dragging the mouse left and right adjusts the zero-order (or A) phase of the spectrum. When
the right mouse button is depressed, dragging the mouse left and right adjusts the first-order (or B) phase
of the spectrum. By default, the phasing pivot point for the B correction is the left end of the spectrum
display. This can be changed, but must be done before entering the PH routine. From the Nuts base
level, hold down the left mouse button, place the cursor where the pivot point should be, and type P.
When the phase is properly adjusted, type <Enter> and the new phase adjustments for the spectrum are
applied. Under some conditions there is a slight difference in the phase for the full data point spectrum
and the reduced data point display. Repeating the PH command (or using PE, below) will usually
correct the problem. This routine works best for smaller data sets or those with broader lines. It is
usually best to adjust the spectrum first using only the zero-order correction (left mouse button), then
make small adjustments using the first-order correction. This is because it is possible to apply a very
large first order correction inadvertently, creating a rolling baseline. You can check this by typing TP
(Total Phase). The B phase parameter should be small, and should definitely NOT exceed 360 degrees.
Should this happen, all phasing can be removed by typing ZP or selecting Zero Phase from the Process/
Phasing menu. Then re-phase. More details are available in the NUTS Help and in the phasing section
at http://www.acornnmr.com/NutsHelp.
The spectrum phase can also be adjusted with the Phase Expanded (PE) subroutine, in which 2 regions
with easy to phase peaks at opposite ends of the spectrum are phased in turn. (Since the total phase is
defined by 2 parameters, determining the correct phase in 2 spectral regions is sufficient to calculate the
phase for the entire spectrum. This is similar to Brukers and Nicolet/GEs cursor phasing process.)
This routine is usually the best way to phase a spectrum consisting of a large number of data points. To
use PE, two regions of the spectrum are first selected for phasing with the Zoom routine. To do this, first
display the full spectrum with Ctrl-F. Enter Zoom (ZO), select a downfield region containing a peak.
Dont expand the spectrum, just highlight it, and type 1; in the same manner, select an upfield region
containing a peak and type 2. This defines the 2 regions to be phased. Now, exit Zoom and enter the
Phase Expanded routine with the PE command. Region 1 is displayed first by default. Press and hold
the left mouse button and adjust the phase of region 1 with left and right mouse movements. The pivot
point (where linear correction is zero) is automatically set to the tallest peak in region 1. Adjusting the
phase with the left mouse button applies a zero-order correction to the entire spectrum. Then, press and
hold the right mouse button and, likewise, adjust the phase of region 2. When both regions are adjusted
properly, exit with <Enter>. The NUTS program will calculate and apply the proper phase correction to
the full spectrum. The selected regions will remain in effect until re-defined or the NUTS program is
exited. In some cases, care needs to be used to keep the B phase correction from rolling over to a very
large number, which results in a wavy baseline. You can check this by typing TP (Total Phase). The B
phase parameter should be small, and should definitely NOT exceed 360 degrees. Should this happen,
all phasing can be removed by typing ZP or selecting Zero Phase from the Process/Phasing menu. Then
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re-phase.
The last manual phasing process is solely command driven (no mouse functions). The amount of phase
correction for the A and B phasing parameters (zero- and first-order corrections, respectively; with the
pivot point at the far left end of the spectrum) can be entered with the PA and PB commands or from the
Process/Conditions menu selection dialog box. After values for A and B phase correction have been
entered, the PC command (or the Process/Phase Correction menu selection) will apply those phase
corrections each time the command is issued. That is, the PC operation adds to whatever phase correction has already been applied, by whatever phasing method has been used. The total amount of phase
correction done to the spectrum will be noted in the Process/Conditions dialog box and will be saved
with the spectrum when the file is saved to disk. Again, one can always zero the phase to start over by
typing ZP or selecting Zero Phase from the Process/Phasing menu.
Same Phase
For a series of spectra acquired with the same spectrometer conditions, the phase correction is usually the
same for each. After the phase correction has been determined for one spectrum, use the PS (Phase
Same) command to apply the same correction to subsequent spectra. Some minor adjustment may be
necessary, which can be done using any of the above methods.

Baseline Correction

NUTS provides several baseline adjustment options to correct the baseline if necessary. Please note it is
always advisable to correct the baseline before attempting integration. Baseline correction commands
include:
BC -- Baseline Correct; removes DC and tilt for entire spectrum
BF -- Baseline Flatten; removes DC and tilt for displayed expanded region
FR -- Flatten Region; removes DC and tilt for displayed expanded region
QB -- Quick polynomial Baseline correction
FB -- Fix Baseline; a subroutine that fits the baseline to a polynomial (not included in NUTS Lite)
The difference between BF anf FR lies in how adjacent regions are affected. BF adjusts the DC level
of adjacent regions to prevent discontinuities, FR does not.
While the first four are just commands (completed immediately), FB is a subroutine and allows user interaction.
QB or FB is recommended, as the entire spectrum is corrected simultaneously and gives good results.
FB is a subroutine that allows user interaction and has more options. QB, in its simplest mode, uses
default selection of baseline points and executes the correction without user input.
QB also has some extended functionality when used in non-2-letter command mode, for handling unusually bad baselines. See details in the Help file (search for QB).
Upon entering FB, NUTS selects a set of baseline points to use in calculating the polynomial. NUTS
divides the spectrum into 64 segments, decides which segments contain only noise, then averages all
points in each noise section to obtain a set of input points for the polynomial fit. The segments are
highlighted in inverse video (usually red) and can be selected or deselected with the mouse. It is
preferable to have a somewhat even distribution of baseline for the calculation; therefore, de-selection
of some of the points near the edges of the spectrum may be appropriate. For historical reasons, 2
different fitting routines are available. The older method is a Simplex fit, and is initiated by typing C. A
least squares fit has been added, and gives equivalent results in much less time, so is the preferred
method. This is initiated by typing L. For some spectra, the least squares method fails, and the user
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should then use C instead. The correction is not applied until the subroutine is exited. Type P to draw
the polynomial fit on the baseline for evaluation of the quality of the fit. <Enter> applies the fit and exits
the FB subroutine. If the fit is not good, adjust the selection of points and execute the fit again, or type X
to exit without applying the correction.
FB Subcommands Include (Commands available from menus):
C: (calculate polynomial) to start the Simplex fit. This is slow, use Least Squares instead.
F: (Fudge baseline) Flattens each region independently by removing DC and tilt for each region.
L: (Least Squares fit to baseline) Newer and faster than Simplex, but occasionally fails.
P: (draw polynomial) draws the calculated polynomial on the baseline of the spectrum.
Q: (quit iteration) to stop the calculation before convergence.
X: (exit) to abort operation without applying fit.
<Enter>: to apply fit and exit.
There are also local baseline correction options within both the Zoom (ZO) and Integrate (ID) subroutines. To apply a simple local baseline correction (corrects DC offset and linear tilt) to a displayed
expanded region in ZO, type B. To apply an interactive correction to a displayed expanded region in
ID, type B. Press and hold the left mouse button and move to the right or left to apply a zero order
correction. Press and hold the right mouse button to apply a first order correction. Caution is recommended when applying a first order correction. Note that this operation does not merely adjust the
displayed integral line, but applies a correction to the spectrum, which remains after exiting this
routine.
Note that any functions which operate on only a region of the spectrum will affect other regions (often
noticeable at the junctions).
For more information, search for Baseline Correction in NUTS Help or at http://www.acornnmr.com/
NutsHelp.

Integration

Please note, it is always advisable to correct the baseline before integrating. If, upon entering the Integration
subroutine, the full spectrum integral is not fairly flat (horizontal) over the baseline, then a correction should be
applied. Exit Integration and do one of the previously discussed baseline corrections. Note also that special
care must be taken when recording integrals after a local baseline correction has been applied, because a
baseline correction applied to only a local region will affect the rest of the spectrum. Thus, corrections of the
entire spectrum are preferred. Please see the note at the end of this section for more information.
In addition to the usual manual integration operation (ID subroutine), NUTS allows automatic integration,
which is invoked by typing AI or from the Tools menu. AI displays an integral of the entire spectrum, broken
into integral regions, and labels each region with its relative value. Execution of this command overrides any
previously defined integral regions and scaling, whether created with AI or manually within the Integral Display
(ID) subroutine. Integrals can be added, deleted and new values assigned manually using the ID routine.
The currently displayed region can be integrated manually by entering the integration subroutine using the menu
selection Process/Integrate, the ID command from the NUTS base level, or the Zoom sub-command I. Upon
entering the integration subroutine the first time, the displayed region will have the standard, full spectrum NMR integration line. The integral is automatically scaled such that it will be full scale height at
the end of the display (full spectrum display). On entering the integration routine, the menu choices
change to display commands which are active. All commands can be accessed using the menus or as
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single letter commands, with the exception of those which involve using the mouse (defining integral
boundaries and choosing an integral for further manipulation). The scroll bar on the left is used to adjust
the height of the displayed integrals. If the integral display goes off the top of the display, it will wrap
around to the bottom of the display. If the spectrum is plotted within ID (P or File/Plot menu), it will
have the integrals plotted on it as they appear on the screen. As with all subroutines, ID is exited with
<Enter>.
Commands within the Integrate subroutine are executed in one of two ways: by typing a single character
(or choosing the equivalent menu selection), or by clicking the left mouse button to bring a vertical line
cursor on screen, positioning the cursor, and then applying a command (again usually a single character).
All commands are described below, separated by category. To break the integral trace into sub-regions
(i.e., to choose separate integrals for separate peaks), click the left mouse button to bring the cursor line
on screen, place the line at the start of the desired region, click the left mouse button again, then place the
line at the end of the region, and (thats right) click the left mouse button yet again. The integral just
chosen will appear on the screen. Separate integrals can be designated from either left to right or right to
left, and in any order. Integral regions can also overlap. Once an integral region is chosen, the full
spectrum integral is no longer displayed; instead the subintegral is displayed over the peak. Note that
adjusting the vertical display of either the integral trace or the spectrum does not change the scaling of
the integral values. This allows plotting of expanded regions, optimizing the scale of each, while
keeping the integral values comparable.
The integral regions are not cleared when a new data set is opened, making it easy to integrate a series of
similar spectra.
ID Single Character Commands (Commands available from menus):
B: (Baseline correction) Pressing the left or right mouse buttons and moving the mouse applies zeroand first-order baseline corrections, respectively. Note that this applies a permanent change to
the baseline, rather than just changing the integral trace. <Enter> to exit.
C: (clear all broken integrals) Clear a set of sub-integrals. This clears the list, but does not affect integral
scaling.
F: (toggle full/broken integral) Toggles between the broken and continuous integral displays.
L: (delete Last integral) Deletes the most recently defined integral region.
M: (toggle integral label position) Toggles among three positions of the integral labels: just below
the end of the integral trace, at the bottom of the screen and at the top of the screen.
P: Print
R: (Read tailer) Reads integral regions and scaling from the files tailer.
T: (type integral list to clipboard) Creates a list of all integrals measured since last C (clear list)
and puts the list into the Windows clipboard for pasting into a document for editing and printing
(such as notepad). The integrals are placed into the list in the order in which they were defined,
but are automatically reordered from largest to smallest chemical shift whenever T is typed.
After typing T, open any word processing program and paste the integrals in. IL from the NUTS
base level is another way to place integrals into the clipboard. Also, Ctrl-B will display the
integral list on the screen, in the upper left corner of the spectrum.
Z: (adjust zero DC position of integral) Actually a sub-subroutine, brings up a second scroll bar at
left. Adjusts the beginning level of the integrals. <Enter> to exit.
ID Mouse Initiated Commands (Commands available from menus):
(Click the left mouse button once, move the cursor to the desired position, and type the command. This is
used to choose a particular integral for some action by putting the cursor on the integral of interest.)
D: Delete a single integral.
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V: Brings up a dialog box for entry of a value (scaling) for the integral.
1,2,3: Slightly changes the position of the integral labels. 1 moves the label up from the default
position, 2 returns to the default position, and 3 moves it down. Useful for reducing overlap of
labels.
If baseline correction of sections of the spectrum is still necessary, then compiling an integral list for the
entire spectrum should be done one section at a time. (Copy the current regions integral information to
the clipboard (T) and paste into the notepad. Then clear the sub-integrals (C) before moving on to the
next region.) Whenever T is typed, all subintegral information is copied to the clipboard, not just those
in the currently displayed region. If baseline correction is applied to the current region, it will change
the baseline (and therefore the integral values) in other parts of the spectrum. (Clearing subintegrals
does not affect the integral scaling.) It is for this reason that baseline correction of the entire spectrum
via a polynomial fit (FB) is the preferred method. Then baseline correction of individual spectral
regions should not be necessary, and this complication is avoided.
If sub-integrals have been defined, then when the spectrum is saved, the integrals are saved in the files
tailer and can be recalled at a later time using the Tailer All (TA) command or the R command within
the integration subroutine.
For related information, see NUTS Help or HTML Help files at http://www.acornnmr.com/NutsHelp.

Peak Picking

Peak picking can be done in one of two ways, automatically with PP (Peak Pick) or manually with DP
(Define Peak). (DP is not available in NUTS Lite.) Both indicate which peaks have been chosen with
vertical lines on the display. PP selects peaks in the displayed region, labels the peaks at the top of the
screen and places the peak list into the Clipboard (for pasting into documents programs, such as Notepad).
Display of the peak labels is toggled on and off with Ctrl-P. The peak list can be displayed on the screen
using the Ctrl-B command. PP operates only on the displayed region; only displayed peaks are selected,
labeled and listed to the clipboard. Typing PP again in a different region replaces the peak list in the
clipboard. Therefore, to compile a total peak list, paste the list for each region into the Notepad, then
proceed to the next region, or create a list from the full spectrum.
Peak labels in ppm, by default, are displayed at the top of the screen, but this can be changed in the
nuts.ini file, as can other default settings. NUTS attempts to avoid overlap of peak labels, but this may
not be possible in cases of very crowded spectra. Display of the labels can be toggled on and off with
Ctrl-P, and the peak list removed with ZL. Numerous other options for peak labeling are available
within the DP subroutine, including labeling peaks in Hz or with user-entered text.
Peaks are selected if they meet 2 criteria: peak height must exceed the minimum height (MH) value and
the peak must decrease by RM multiples of RMS noise after reaching a maximum. (This latter is to
avoid picking multiple peaks for a broad peak in a noisy spectrum.) The simplest way to determine
the optimum value for MH is by using the cursor from the base level of NUTS (not in Zoom). Hold down
the left mouse button to display a full-window crosshair cursor. Place the horizontal cursor line at the
height you want for the threshold and type M. Peaks above this threshold are selected. pick peaks that
meet this new criterion. Minimum height may also be entered by typing MH, which brings up a dialog
box and allows a value to be entered. The values are expressed as a percentage of the largest peak in the
spectrum, smaller values pick smaller peaks. Typing RM brings up a dialog box also, for changing the
sensitivity. Decrease RM if splittings are being missed in a noisy spectrum.
By default, NUTS uses interpolation to find the peak maximum, which gives a more accurate value for
the peak frequency. The interpolation can be turned off from the NUTS base level. Press and hold the
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left mouse button and type O. This brings up a dialog box in which the interpolation is set. [Note this
is the same operation as is used to set the chemical shift reference.]
In addition to automatic peak picking, NUTS allows peaks to be selected manually using the cursor in
the DP (Define Peaks) subroutine. On entering the subroutine, the cursor changes to a small crosshair
cursor labeled DP as a cue to the user, and the status bar shows Define Peaks. Commands within this
routine are single letter commands which are executed immediately and are also available from the
menus. Place the cursor on the chosen peak and click the left mouse button to select it. By default, NUTS
finds the nearest maximum (positive or negative) to the cursor location, but this Snap to feature can be
disabled from the Edit menu. A vertical red line indicates each peak which has been selected. Labels
are toggled on and off with Control-P. Each peak label can be moved using the mouse.
DP Subcommands Include (Commands available from menus):
(Not available in Nuts Lite)
(See NUTS Help or http://www.acornnmr.com/NutsHelp for details.)
A: (auto peak pick region) Automatically select all peaks above the MH value (like PP).
C: (clear all peaks) Delete all peaks.
H: (labels in Hz) Toggles display of peak frequency in Hz or ppm.
I:

(Information labels) Toggles peak labels in frequency or using text labels.

K: (kill peak closest to cursor) Place cursor over or near peak of interest (do not click button) and
type K to delete the chosen peak.
T: (type peak list to clipboard) As peaks are selected, the peak information (shift in Hz and PPM,
height, etc.) is entered into a list. T places the selected peaks into the Windows clipboard for
pasting into document programs. If the clipboard display has been toggled on (Ctrl-B), the list
will be displayed on the screen, and is updated each time T is typed.
#: (# = shift 3 ) (reorder list) Reorders list from highest to lowest chemical shift. T must be typed
again to place the reordered list into the clipboard.
There are other options available. Examine the choices listed in the Edit menu, and the information
displayed by clicking the right mouse button near a selected peak.
Peaks can be labeled with their shifts, in PPM or Hz, or with a text label, after being selected in the DP
routine by typing Ctrl-P, which is active in the base level of NUTS and all subroutines. Ctrl-P is a
toggle, so typing it again turns off display of peak labels. The font for the peak labels can be changed by
selecting Set Fonts from the Edit menu. From within the DP subroutine, a chosen peaks information can
be displayed by placing the mouse on or near the peak and clicking the right mouse button. A dialog box
is displayed with that peaks information. Only the Label (at the bottom) can be edited, which by default
gives the peak number. There is a check box which allows the user to choose to display the peak labels
either horizontally or vertically for each peak independently. This preference can also be set in the
nuts.ini file. (The fonts used for horizontal and vertical peak labels can be set independently by choosing Set Fonts from the Edit menu at the Nuts base level.) There is also a check box labeled Show first
argument only. This is for situations where extensive information has been input in the text label box,
which can be too long to display above each peak. If this box is checked, only the characters up to the
first space are used to label the peak. This could be the case if the user enters extensive comments such
as substructure codes and assignments to be saved in the files tailer. By default, peaks are labeled with
chemical shifts in ppm. The text label can be used instead by choosing Show Peak Information Label
from the Edit menu. Also from the Edit menu is the option of labeling the peaks in Hz rather than ppm.
Other check boxes allow choices of 1) displaying each label at the top of the page or immediately above
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the peak; 2) drawing a line from the label to the top of the peak; and 3) displaying the text label for a
chosen peak, while using ppm labels for others.
It is possible to adjust the position of each peak label using the mouse. Position the cursor on the label of
interest, press and hold the left mouse button and drag the label to the desired position. It is also
possible to select whether each label is displayed vertically or horizontally using the check box in the
information dialog box, displayed by clicking with the right mouse button. The default peak label
orientation can also be set in the nuts.ini file.
The peak list is not lost on exiting the DP routine. When the routine is re-entered, the previously defined
peaks are still in the list, even if they are not in the currently displayed region. To operate on a new
spectrum, zero all peaks (with C or from the Edit menu) before picking new peaks. If peaks have been
defined with DP, and then the file is saved, the peak list is saved in the files tailer, and can be recalled
later with the (Tailer All) TA command.

Inset Plots, chemical structures and company logos

Inset plots, chemical structures and other graphical objects can be displayed within a spectrum using
tools provided in the Meta Object subroutine (MO). (A second subroutine for handling inset plots was
added with version 980123; see below). Graphical objects (metafiles for Windows or PICT files on a
Macintosh) can be pasted from the clipboard or imported from files. More than one object can be
displayed on the screen, and each can be independently moved and resized using the mouse. The
program keeps track of them in a linked list. To select which object to operate on, move through the list,
forward or backward, until the desired object is indicated with a box with handles.
The MO subroutine does not display menus, but instead has a helper box which has buttons for each
operation. The buttons are labeled with the corresponding keyboard command. The helper box can be
toggled on and off from the Help menu at the base level of the program, and in the nuts.ini file.
To create an inset plot, the subroutine captures the currently displayed region of a spectrum as a meta object
(vector drawing object). The object will appear on the screen in a separate box with sizing handles. The
object can be moved and scaled using the left mouse button. There is no limitation on the origin, number or
placement of the inset plots. Once an inset plot is created, it must be explicitly deleted or it will carry over from
one spectrum to another. This means the user can display inset plots from one spectrum on another. This can
be useful for simultaneously displaying spectra of different nuclei. To create an inset, first expand the current
spectrum to display the region desired as the inset plot. Exit the Zoom subroutine and type MO. Then type A
to add the currently displayed region to a linked list of plot insets. <Enter> will exit the subroutine. Repeat to
display as many regions as desired. To delete an inset plot, choose the inset plot with the left mouse button and
type D. Sometimes the axis font of the inset is too small. The size can be increased by increasing the
axis font mulitplier in the Helper window. This will not change the font of an inset previously created.
There are two ways to display a structure or other graphical object other than an inset plot: by pasting
from the clipboard or by importing from a file. Objects pasted from the clipboard are volatile, and are
not saved when Nuts is closed. For an object imported from a file, a pointer to that file is saved in the
files tailer when the Nuts file is saved, and can be recalled at a later date when that file is opened in
Nuts.
MO Subcommands:
A: (add) Add currently displayed region to linked list of inset plots.
C: Paste graphical object from the Clipboard
D: (Delete) Delete current Meta Object in linked list.
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I: Import an object from a file.
N: (Next) Move to next Meta object in linked list.
R: (pRevious) Move to previous Meta Object in linked list.
Shift-F1 brings up Help for the MO subroutine
<Enter> exit the MO subroutine
A company logo can be displayed on the screen and plots. The metafile to be used, its size and position
are defined in the nuts.ini file.

Inset plots (IS subroutine)
(not available in Nuts Lite)

A second subroutine for creating inset plots was added starting with version 980123. Use the Zoom
routine to define the region which will be captured for the inset. It is not necessary to expand the
display to the zoom limits. Enter the Inset subroutine by typing IS or from the Tools menu. Typing
A (also available from the Edit menu) creates an inset plot of the Zoom region. This can be moved
and resized with the mouse. Clicking on the inset with the right mouse button brings up a dialog box
allowing several properties to be set. The axis units, axis font and axis tick mark density can be set
individually for each inset. There is also a box to set a chosen plot scale in Hz/cm. This should be
tested for each printer, and an adjustment entered in the fudge box if necessary.
Display of insets can be toggled on and off from within the IS routine with the S subcommand, and all
insets deleted with C. Exit the subroutine by typing <Enter>.
There are some important differences between this routine and the MO routine. In IS, the insets
position is tied to a data point in the spectrum corresponding to the left edge of the inset. Therefore, if
the expanded region is changed, some insets may not be displayed. (In the MO routine, objects are
positioned relative to the screen, regardless of what part of the spectrum is displayed.) With IS, the
insets are generated dynamically, rather than being frozen at the time of their creation. This means that
if a different data set is read in, insets will be created from the corresponding data points in the new
spectrum.

Text annotation (NO subroutine)
(not available in Nuts Lite)
This subroutine, added starting with version 980123, allows the user to define multiple text objects
(notes) whose position and font can be adjusted independently. Enter the subroutine by typing NO or
from the Tools menu. Clicking with the left mouse button or typing A brings up a dialog box into
which the desired text is typed. A button allows the font to be set. Note that the font change is not
shown while in the text entry box, but will be applied when the box is closed with OK. The text of a
given note can be edited by clicking on it with the right mouse button. Each note can be moved around
on the screen, but not resized. (To resize, change the font size.) All notes can be removed by typing C
(also available from the Edit menu). Display of all notes can be toggled on and off by typing S (also
available from the View menu) or with Ctrl-N (active outside the subroutine).
Text can be pasted into a Notes box with Ctrl-V (Win 95/NT) or Command-V (Mac). (This does not
work in Win 3.11)
The subcommand P is used to define a special note, containing the acquisition parameters for the
current data set. This is equivalent to the LP command from the NUTS base level.
As with the IS routine, each object is tied to a data point, not to a position on the screen.
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NO Subcommands:
A: (Add) Add a note.
C: (Clear) Delete all notes
P: (Parameters) Create a note containing acquisition parameters for current data.
S: (Show) Toggle on/off display of all notes.
<Enter> exit the NO subroutine

Add/Subtract
(not available in Nuts Lite)
NUTS allows two spectra to be displayed simultaneously for viewing, and also allows addition and
subtraction. One spectrum is placed in a buffer using the AL command (also available from the Tools/AddSubtract
menu) and the second spectrum is then opened. From the NUTS base level, the Dual Display command DD
(also available from View menu) toggles between display of a single spectrum and both spectra, with the buffer
spectrum shown above the current spectrum. Note that the loaded spectrum remains unchanged in the buffer
until another spectrum is loaded with AL.
The Add/Subtract subroutine allows addition and subtraction of these two spectra. Typing AS or choosing Add/Subtract from the Tools menu enters the Add/Subtract subroutine. The menu choices change to
those which are active in the subroutine. The spectrum in the buffer is displayed above the current
spectrum. Commands within the subroutine are single letter commands executed immediately, and are
available either from the keyboard or from the menus.
AS Subcommands Include (Commands available from menus):
+/-: (add data/subtract data) Adds or subtracts the buffer spectrum from the current spectrum, respectively. The result becomes the current spectrum, while the buffer spectrum (top) remains unchanged in
the display. Subtraction is current spectrum minus buffer spectrum.
M: (change multiplier) Brings up a dialog box allowing entry of a multiplying factor for the buffer
spectrum. This changes the relative intensities of the 2 spectra; the default is 1.
O: (change horizontal offset) Brings up a dialog box for entry of a spectral offset. Enter the number
of horizontal points (positive or negative) desired to shift the buffer spectrum with respect to the
current spectrum. For fine alignment of two spectra, the spectrum can also be shifted by 1 point
with the right and left arrow keys, or by 10 points when the shift key is depressed along with the
right and left arrow keys.
V: (change vertical position) Brings up a dialog box for entry of a vertical offset of the buffer
spectrum. The offset is expressed as a percentage of the screen: thus, 10 displays the buffer
spectrum 10% above the bottom. To adjust the current spectrums offset, exit AS (with <Enter>)
and type DC (another subroutine). Use the scroll bar on the left to adjust offset, then <Enter> to
exit the DC routine. Re-enter AS if desired.
D: (difference) In place of the buffer spectrum, displays the difference between the spectra (current
spectrum minus buffer spectrum). While displayed, parameters such as M and O can be adjusted, and
the difference spectrum is updated in real time. After adjustment of the parameters, subtraction can be
performed (minus sign (-) or from edit menu). Note once the difference display is activated, it stays
activated until explicitly turned off (with B or Display/Both Spectrum and Buffer Data menu
selection), even if AS is exited and re-entered.
B: (both spectrum and buffer data) Displays the buffer and current spectra.
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For more information, Search NUTS Help or section on Add/Subtract at http://www.acornnmr.com/
NutsHelp.

Buffers subroutine
(not available in Nuts Lite)
Display of more than 2 spectra can be accomplished with the Buffers routine, which provides 10 buffers
into which all or part of a spectrum can be placed. The spectra in any or all buffers are displayed above
the current spectrum such that the ppm scale is the same for all. NUTS will adjust the display of each
spectrum to compensate for different parameters. Spectra can be displayed together even in cases where
spectrometer frequency, sweep width and number of data points are not equal. Vertical scaling factor
and vertical position of each buffer can be set independently.
The Buffers subroutine is entered by typing BU (not yet in menus). As with all subroutines, the Enter key
will exit the routine. While in the Buffers subroutine, the displayed region of the current spectrum can be
placed into any of the buffers, numbered 0 to 9. Choose the target buffer from the Transfer menu. Any
chosen buffer can be cleared using the Clear menu. Display of the contents of each buffer can be toggled
on and off from the View menu. An option in the View menu also allows the buffer contents to be
displayed after exiting the Buffers subroutine.
When data is placed into a buffer, the contents of that buffer are displayed using default parameters,
which can be changed from the Edit menu. A vertical scaling factor and vertical display offset can be
entered independently for each buffer. Each buffer is identified by a small number (0 to 9) which is
displayed at the left end of the buffer. This identifier is shown only while in the subroutine.
Other menus allow addition, subtraction, multiplication and division of any chosen buffer with the
current spectrum.
Vertical scale adjustments (made with the scroll bar or page up/down keys) and horizontal expansions
(defined with the Zoom subroutine) affect the current spectrum and all buffers.

Line fitting
(not available in Nuts Lite)
This subroutine adjusts parameters of a set of lines to fit peaks in a real spectrum. The parameters are
frequency, height, width at half height, and ratio of Lorentzian/Gaussian lineshape (expressed as percent
Lorentzian). The user enters a set of initial peaks which will be varied in a Simplex optimization to find the best
fit. Note that in complex cases involving overlapping lines, this process may require an iterative approach with
user input along the way.
The subcommands described below are single-letter commands which are executed immediately. All
subcommands can be accessed via the menus or typed on the keyboard.
Note, before the line fitting (LF) subroutine is entered, a Baseline Flatten (BF) operation should first be
performed on the displayed region of the spectrum, which changes the data. This is to be sure that the
baseline in the region being fit is flat; otherwise, the fit will not be very good.
To begin, use Zoom to expand the spectrum so only the peaks of interest are displayed, then exit Zoom
(with <Enter>). Type LF or select Line Fitting from the Tools menu to enter the fitting subroutine.
Note the menu bar has changed to display commands which are active.
First, pick a set of peaks as a starting point. There are three ways to input a set of peaks:
1. By manually picking the top of the peak using the mouse cursor. Hold down the left mouse button,
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place the crosshair cursor at the top of one of the peaks and then release the mouse button.
2. Pick the peaks position by letting the software find the peak maximum. Instead of placing the
crosshair cursor on the peak maximum, place it directly below the peak, below the axis, and release the
mouse button. NUTS finds the peak maximum and positions the line at that frequency, provided the
cursor is placed within +/- 2 data points of the position of the peak maximum.
3. By using the peak picking function. NUTS finds all of the displayed peaks positions (maxima) and
heights. Just type P and all of the displayed peaks which meet the specified RMS noise and minimum
height parameters, are picked and Lorentzian lines are drawn for each one (see P below).
Each time a peak is added, a red Lorentzian line (not yet fit) will appear superimposed on the spectrum.
Previous lines are in green. To adjust the current (red) lines width, place the cursor at the half height of the
current peak (the width you want the line to be) and click the right mouse button.
More lines can be added in the same manner as the first. Notice the current line is always in red and all
others are in green.
NUTS keeps track of peaks as they are created by placing each peak, along with its parameters, into a
list. Peaks are placed into the list in the order they are created. However, the list can be reordered by
chemical shift (high to low), by typing R (or choosing Edit/reorder LF list from the menu). NUTS keeps
track of a peak in the list by coloring the current peak red. This pointer can be moved forward or
backward through the list, so that each peak in turn can become the current peak. Step through the list
with F (forward) or B (backward) (or from the Edit menu).
The parameters of the current peak can be displayed by typing I, which displays a dialog box. This is
useful for setting Relative Area to some convenient number, to make peak areas easier to compare. To
display the parameters of another peak, either step through the list by clicking previous or next in the
dialog box, or enter a peak number (numbered in order created, or if reordered, by chemical shift).
The Information dialog box (displayed with I) also allows the user to select which parameters will be
adjusted during the fitting process. This can be done independently for each parameter (height, width,
frequency and lineshape) and for each peak. When the box marked Iterate is checked, this parameter
will be adjusted during the fit.
LF Subcommands Include (Commands available from menus):
I:

(information on line) To view a peaks parameters. Brings up a dialog box. Any parameter,
except absolute intensity, can be adjusted and applied by clicking the Apply button. It is easier to
compare peak areas if the Relative Area of one peak is assigned to a convenient value, such as
one. All other peaks will have Relative Areas scaled to this value. Close the dialog box to
return to the spectrum.

O: (optimize current line) To perform a Simplex fit to the current line. The red line will display the
result of the fit.
T: (type peak list to clipboard) Places the parameters into the Windows clipboard. The parameters
can then be pasted into the Windows Notepad or any other word processing program for editing.
P: (peak pick) Performs peak picking in the same manner as the PP command used at the base level
of NUTS, and displays Lorentzian lines at the position of each peak. If not all peaks are selected,
the user can adjust the parameters for minimum height (MH) and RMS noise factor (RM) by
typing M, which brings up a dialog box for adjusting these 2 parameters. Zero the previously
selected peaks (Z) and type P again. Note, P will add to any peaks previously selected.
M: (minimum height) See P. Brings up a dialog box for adjusting MH and RM.
F: (move forward one peak) Moves to the next line in the list (Forward)
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B: (move back one peak) Moves to the previous line in the list (Backward).
R: (reorder LF list) Reorders lines from largest to smallest chemical shift
D: (delete current peak) Deletes the current line (in red). Note, deleting lines can change the order
in the list. If, for example, the third line out of a list of 5 is deleted, then a new line is added, the
new line will be fifth (last) in the list.
A: (optimize all lines) Initiates the Simplex fit on all lines (All lines should be initialized and
adjusted to some reasonable starting parameters). This can take a minute or more if the fit
consists of several lines, as the dimensionality of the problem is large (4 times the number of
lines). To fit a group of overlapping peaks, it works best if the starting point is as close as
possible. Try optimizing each line individually (with O) before starting the complete fitting
routine (A). The Simplex routine has been implemented to perform a fairly quick fit so that the
user gets an indication of the progress. After one iteration, adjustments can be made to individual lines as needed and then type A again. Since the starting point for the second iteration is
closer, the result will be better.
Z: (zero all peaks) Zeroes all peaks.
Options for displaying the calculated peaks (Commands available from menus):
S: (sum of lines) Displays the sum of the lines, which should overlay the real spectrum.
L: (individual lines) Displays the individual lines.
+: (shift =) (both) Displays both the sum and the individual lines.
-:

(difference) Displays the difference between the real and calculated spectrum.

.:

(period key) Toggles the display of individual lines between a solid and a dotted line.

C: (digitized calculated spectrum)
To perform the fit to the real spectrum, the LF routine first digitizes the theoretical line to match the real peak
point for point. View the digitized calculated spectrum with C.
Exiting the line fitting subroutine (with <Enter>) does not delete the calculated lines. Therefore, one can
exit and change the frequency limits of the spectrum and then reenter LF. The calculated lines will be
adjusted to reflect the new display. Note this could result in the fit operating on peaks which are not
displayed.
The option exists of saving the calculated spectrum and/or the list of parameters which define the calculated
peaks (position, height and width for each line). Once a calculated spectrum has been saved, it can be opened
and manipulated exactly as any real spectrum. A previously saved list of parameters can be opened and the
resulting calculated spectrum will be displayed. This allows the user to save a template for repeated use on
a series of spectra. These options are available under the File menu.
For a summary of LF subcommands, use Help and Search for LF and see section on deconvolution at http://
www.acornnmr.com/NutsHelp.

NMR Simulation
(not available in Nuts Lite)
This NUTS subroutine calculates and displays a spectrum based on user-input values for chemical shifts
and coupling constants for up to twelve interacting spins. NUTS makes the assumption that in most
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cases, the user wants to fit a calculated spectrum to a real spectrum. Therefore, this routine uses the
values of Spectrometer Frequency, Sweep Width, Spectrum Offset and Number of Points from the current spectrum for its calculation. (It is possible to change these values; see below.) The simplest way to
get a starting set of parameters for a simulation is to first open a spectrum file in NUTS, before entering
the NS subroutine. Sub-commands can be accessed via the menus or by typing single-letter commands
(found next to the corresponding operation in the menu displays). A list of subcommands is given below.
To begin, type NS or select Simulation from the Tools menu to enter the simulation subroutine. The menus will
change to reflect the choices within the subroutine. Type A or choose Add/Edit Simulation Data from the
Edit menu to bring up a dialog box for entering data. First, enter the number of spins, then the chemical
shifts (in either Hz or PPM; set units in lower left corner). To enter coupling constants, click on the
button labeled Enter Coupling values. (This is now displayed on a separate screen, because there is too
much data to fit on a single screen.) To enter data for degenerate spins (e.g., a methyl group), enter each
as a separate spin with the same value for chemical shift and couplings to other nuclei. (The couplings
among degenerate spins are zero.) When finished, click on Accept and Recalculate, which closes the
dialog box, performs the simulation and displays the resulting spectrum. Repeat this process to adjust
the input parameters. Alternatively, to close the dialog box without calculating the spectrum, choose
Accept Changes. (It is often desirable, in the course of entering parameters for the calculation, to
close the parameter entry dialog box and refer back to the real spectrum, without having to wait for the
calculation to be performed.) The values which have been input are saved, but the spectrum is not
calculated. This can be repeated until all values are entered and then the Accept and Recalculate
option performs the calculation. In addition, when the simulation subroutine is exited (with <Enter>),
the input data are not lost. This means it is possible to exit and re-enter the simulation subroutine without
penalty.
1
Within the data input dialog box is a field labeled Nuclei. By default, all nuclei are taken to be H, on the
assumption that this is the most common situation. It is important to note the actual label is irrelevant; the only
important point is whether or not all spins have the same label. If the Nuclei labels of 2 of the spins are
set to be different, second order interactions between those 2 spins are ignored. (This can be used to
compare the results obtained for a given set of input parameters with and without consideration of
second order effects.) To simulate a heteronuclear case, simply make the chemical shift of the
heteronucleus very different from the others; the Nuclei labels need not be changed.

To compare real and simulated spectra, type B or choose Both from the Display menu. The vertical
scale of both spectra can be adjusted with either the right-hand scroll bar, Page UP/Page Down keys or
the </> keys. To adjust the vertical scale of just the simulated spectrum, type L (Change LB/Amplitude
from the Edit menu), which brings up a dialog box allowing the linewidth and/or scale of the simulated
spectrum to be adjusted, without having to re-do the entire calculation. Also it may be easier to view
real and calculated spectra if the DC offset of the real spectrum is changed. To do this, exit NS, change
DC and re-enter NS. While in the simulation subroutine, the cursor readout works as usual. With either
only the simulated spectrum (C) or both real and simulated spectra (B) displayed, shifts and coupling
constants can be measured by holding down the left mouse button, just as in the base level of NUTS.
Within the simulation subroutine, one can enter Zoom to change the displayed region from the Display
menu or by typing Z (not ZO). The cursor changes to the Zoom crosshair while in Zoom, and typing
<Enter> exits Zoom and returns to NS. Note, however, not all Zoom options are available. Also, as the
calculated spectrum is not digitized in the way a real spectrum is, the Zoom routine uses the digital
resolution of the current real spectrum, which if poor, can limit the ability to Zoom in on a narrow
spectral region within NS.
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When experimenting with spectrum simulations which are not matched to a real spectrum, it may be
desirable to change the values of Spectrometer Frequency, Sweep Width, Spectrum Offset and Number
of Points (do this outside of NS). With the exception of Number of Points, these parameters can most
simply be changed by bringing up the Parameter dialog box from the Parameters menu in the base level
of NUTS and entering new values. Alternatively, these parameters have the individual commands, SF,
SW, and O1, respectively. To change Number of Points, choose File New from the File menu (or type
FN), which brings up a dialog box allowing parameters to be set. Re-enter NS and execute Recalculate
(R) to implement the changes. Note the time required to calculate a spectrum is independent of the
Number of Points.
The simulation data can be saved as a text file containing both the input parameters and the calculated
data as a list of frequencies and intensities. A previously saved simulation file can be opened from
within the simulation subroutine and the resulting spectrum displayed. Note that if the current value for
SF is different from that which was saved with the simulation file, the 2 spectra (real and simulated)
cannot be compared until the simulation is recalculated. Also, regardless of whether the chemical shifts
were entered as Hz or PPM, they are saved in the simulation file as PPM. Saving and reading simulation
can be done from the File menu (see commands below).
The simulated spectrum can also be saved as an FID. The resulting file can be manipulated in the same
manner as real data. The FID is created from the calculated transition frequencies and intensities. The
time required to generate the FID depends on the current Number of Points. Note if the digital resolution
(Hz per point) is less than the linewidth used in the simulation, the resulting spectrum may be distorted.
The spectrum can be printed by choosing Print from the File menu. Whatever is currently displayed
(e.g., the simulated spectrum or both real and simulated spectra) will appear on the plot. The currently
displayed screen can also be copied to the Windows clipboard for pasting into a document with Ctrl-C
(Copy Screen option from the Edit menu).
The time required to calculate a spectrum depends on the number of spins and on the speed of the
computer. Calculations involving up to 6 or 7 spins are usually quite fast, but the time required goes up
dramatically for each spin added. A 10-spin simulation takes a few hours, even on a 90 MHz Pentium,
and we have not timed a 12-spin simulation. Optimization involves performing the calculation many
times, so is therefore practical only on smaller spin systems.
The simulation subroutine includes the option of performing a Simplex optimization of spectral parameters to match a real spectrum. This is available from the Optimize menu or by typing O. Be advised
that this process involves a huge number of calculations and therefore, can be very time-consuming. It is
best to adjust parameters manually first to be as close as possible before attempting optimization. Note
the optimization is not constrained to keeping shifts or coupling constants of degenerate spins the same,
so that after optimization degenerate spins may have slightly different values. These can be adjusted
manually and, if desired, the optimization repeated.
NS Subcommands Include (Commands available from menus):
A: (add/edit simulation data) Brings up a dialog box for entry of spin information for simulation.
B: (both spectrum and calculation) Display Both simulated and real spectra.
C: (calculated spectrum only) Display Calculated spectrum only.
D: (digitized calculated spectrum) Display Digitized calculated spectrum.
F: (calculate and save FID) Generate FID from calculated transition frequencies and intensities.
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G: (open simulation file) Get simulation data from file.
O: (simplex optimization) Perform Simplex fit to real spectrum.
Q: Quit drawing spectrum. Interrupts a slow drawing operation. Also interrupts optimization.
R: (recalculate) Re-calculate spectrum based on input data.
S: (save simulation file) Save simulated data to text file.
Z: (enter ZOOM routine) Enter ZOOM subroutine to alter displayed frequency range. (Not all
ZOOM functions are active.)
Ctrl-C:
-:

(copy screen) Copy currently displayed spectrum to Windows clipboard.

(minus sign) (Difference) Display difference between real and calculated spectra.

Linked Command Lists for Automation of Processing

A frequently used sequence of commands can be combined into a Link (or command string), which
is then executed with a single command. A simple example of a useful Link would be
BC FT AP
which performs baseline correction of the FID followed by an FT and then auto phasing of the spectrum, with a single command. The current version of NUTS provides for 10 such command strings,
labeled L0 through L9. Typing L# (where # is a number between 0 and 9) brings up a dialog box for
editing of the command strings. Spaces are ignored when a string is edited, but can be inserted to make
the list more readable. Commonly used Linked Lists can be defined in the NUTS.INI file, in which case, their
definitions are established each time NUTS is run.
A command string can be executed by typing the command A#, where # corresponds to the chosen Link.
Alternatively, a command string can be executed by clicking on the corresponding button in the Link
dialog box and then clicking OK.
If the data files being opened in a Link have not yet been translated into the NUTS file format, use IM
rather than GA to open the file. For example, to import a series of 1D files (assuming they have the same
file name with sequential file extensions) and save them as a series of 1D files with a different name, use
the following Link:
IM SB IN
You will be prompted for the names of the files. The IN command increments the extension of both the
file being read and the file being saved, and loops to the beginning. It is not necessary to specify the
number of files; the process will stop when the next file cannot be found.
For more information, search NUTS Help or http://www.acornnmr.com/NutsHelp for help on NUTS.INI
file, T1 Data Processing example, Macros, 2D Processing, Stacked Plots.

Macros

In addition to the Linked Lists described above, NUTS provides macros, which permit more complex
tasks to be automated. Macros are text files and can be created and edited with any text editor, such as
the Windows Notepad. Several sample macros are included with NUTS and can be found in the Mac
subdirectory of NUTS. (New macros can also be found on the Acorn NMR web site (http://
www.acornnmr.com), with text explaining their use.) To execute a macro, type RU or choose Run
Macro from the file menu.
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Macros are files which can contain several Linked Lists within them, as well as single commands and
comments. A line can be any valid NUTS command or command string (Linked List) or special macro
commands listed below. NUTS will ignore blank lines or any line which starts with a space or a
semicolon (for comment lines). The first line of a NUTS macro must be NUTSMacro, and the last line
must be END.
NUTS looks at the first word on each line of a macro and expects to find either a valid NUTS command
or one of the following:
Set

To set the value of some parameter. The format of the Set command is:
Set parameter [value] Some parameters require a value to be specified, others do not. The
sorts of parameters that can be set are frequency limits for expansion, chemical shift reference,
integral regions and values, parameters for window functions, etc. For a list of valid parameters, see Help on Macros or http://www.acornnmr.com/NutsHelp/Macro.html

;

(semicolon) For comment lines; NUTS ignores the line.

Ask

To request user input for a file name. The format of the Ask command is:
Ask parameter Where parameter can have one of the following values: FileA, FileB, FileC,
FileImport, ExportFile, SL, LB, GF, T1, T2 or S#.

Do

Execute an instruction. Valid uses are:
Do DeleteFile filename Deletes specified file without asking for confirmation
Do Extract_PPM f1 f2 This is used to perform an extraction of a spectral region defined by f1
and f2 (in ppm). This is similar to the XT command.
Do Math This is used to perform mathematical operations. See next page.

Call

Call an external program.

^M Executes <Enter>. Equivalent to Control-M. Similarly, other Ctrl commands can be entered.
There is also a set of macro commands for performing Math functions. These are discussed in the next
section.
Sample macros are supplied which can be used as a starting point for creating customized macros.
When writing a new macro, it is advisable to test each new part (by commenting out parts not needing
testing) to be sure it does what is expected. The display is not updated during macro execution (to save
time), so it is not possible to see the results of each step (although commands are echoed on the command
line). Hence the recommendation for testing.
Some of the sample macros perform operations which result in files being written at intermediate stages.
The macro sets default names for these files so the user does not need to enter them. Any such macro will
overwrite those files the next time it is run, so files which the user wishes to save must be renamed
before the macro is run again.
A sample macro, with description of each line, can be found in the 2D section, page 26.
NUTS has the option of a defining macro which is executed whenever NUTS is started. The name of this
macro is set in the nuts.ini file with a line such as
AutoExecMacro = C:\NUTS\MAC\GET_EB.MAC

Math functions

(not included in NUTS Lite)
A new routine for doing calculations (Math) was added in version 981104. While the routine can be used as
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a calculator from the user interface (entered with command MA), its utility is in use within macros.
The following definintions may make more sense if you examine the Math screen by typing MA.
There are 10 REGISTER, 100 MEMORY and 10 INTEGRAL locations. The REGISTERs act like a
stack, similar to an RPN calculator. When a math operation is done, it is performed between REGISTER_0 and REGISTER_1. The answer is put in REGISTER_0 and REGISTERs 2 thru 9 roll down
one level. There is one comment field which can be placed into a NOTE (text annotation), along with
the contents of Register 0, so results are displayed on the screen. An example of a macro is shown
below.
Macro commands
Use of the ENTER function puts the value in REGISTER_0 and rolls the stack up. For example, the
following command places 7 into Register 0, and all other Registers roll up one level.
DO MATH ENTER 7
Any location can be set to a specific value, such as
SET MATH REGISTER x value
Set Reg x to value
To clear all register, integral and memory locations,
DO MATH CLEAR
The math operations possible are add, subtract, multiply, divide, reciprocal, natural log, log base 10,
exponential and power.
The following operations are performed on Registers 0 and 1, and the result is then placed into Register 0.
DO MATH +
DO MATH Register 1 - Register 0
DO MATH *
DO MATH /
Register 1 / Register 0
DO MATH POWER
Reg0**Reg1
These operations are performed on the contents of Register 0:
DO MATH RECIPROCAL
1/Reg0
DO MATH EXP
DO MATH LN
Natural Log
DO MATH LOG
Log Base 10
Other Math commands allow parameters such as SF, SW and Offset (in either dimension) to be set to
the value currently in Register 0, or to place the value of one of these parameters into a specified
Memory or Register location. For example,
DO MATH OF1
Put 1st dimension offset (O1) into Reg 0
DO MATH REGISTER x OF2
Put 2nd Dim O2 into Reg x
See http://www.acornnmr.com/NutsHelp/math.htm for a complete list of allowed commands.
Other commands allow numbers to be moved around within the Memory, Register and Integral locations:
DO MATH REGISTER x REGISTER y
copy contents of Reg x to Reg y
DO MATH REGISTER x MEMORY y
copy contents of Reg x to Mem y
DO MATH MEMORY x REGISTER y
copy contents of Mem x to Reg y
DO MATH INTEGRAL x REGISTER y
copy contents of Integral x to Reg y
DO MATH INTEGRAL x MEMORY y
copy contents of Integral x to Mem y
The Zoom regions (Z0 - Z9) can be set from values in the Registers. The line below sets Zoom Region
i. The value in register x becomes the left end of Zoom Region i (in ppm), and the value in register y
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becomes the right end (in ppm).
DO MATH ZOOM_REGION i x y
The following pair of commands creates a NOTE (text annotation) consisting of the COMMENT and
the contents of Register 0, and displays it at specified screen position (x_pos, y_pos) (in percent of
display, a number between 0 and 100)
SET MATH COMMENT string
Make string a comment for output
DO MATH NOTE x_pos y_pos
To set the number of decimal places printed in the NOTE,
SET MATH DECPLACES x
To automatically measure pre-defined integrals, the integral limits must first be defined using the Set
Zoom Region command. (Do not confuse this with the Set Integral macro commands.) After all regions
are defined, a single command, DO MATH GET_INT, measures all values and places them into the
corresponding INTEGRAL locations. For example, The following sequence defines 2 integrals (7.4 7 ppm and 6.2 - 6.0 ppm), named as regions 1 and 2, and then the Get_Int command puts the integrals
of those regions into Integral locations 1 and 2. It is importante to understand that the DO MATH
GET_INT command measures the integrals of all defined zoom regions.
set zoom_region 1 7.4 7
set zoom_region 2 6.2 6.0
do math get_int
These commands are used to request user to enter values at runtime. The entered value is placed in the
specified location.
ASK MATH REGISTER x Ask for a value for Reg x
ASK MATH MEMORY x Ask for a value for Mem x
Example: The following is a macro which measures the mole% of 2 impurities, relative to the major
component.
NutsMacro math test
; ask name of file to open
ask filea
ga
; clear any old Notes
no
c
^m
; integrals of 1 proton each from major component
set zoom_region 1 7.17 7.04
set zoom_region 2 7.27 7.18
; integral of impurity #1
set zoom_region 3 6.02 5.96
; integral of impurity #2
set zoom_region 4 2.72 2.68
; now get the integrals and place into Integral locations in Math routine
do math get_int
; average integrals of 2 protons from major component. Move integrals from major component
; into registers 0 and 1, add them, divide by 2.
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do math integral 1 register 0
do math enter 1
do math integral 2 register 0
do math +
do math enter 2
do math /
; Put result into memory location for later retrieval
do math register 0 memory 7
; impurity peak #1 is from 2 protons, so move it to register 0, enter value of 2, divide, then move to
memory location
do math enter 1
do math integral 3 register 0
do math enter 2
do math /
do math register 0 memory 1
; calc mole % imp 1. Divide previous result by integral of main component, mult by 100
do math enter 1
do math memory 7 register 0
do math /
do math enter 100
do math *
; Set comment, output result at specified screen location
set math comment Mole % Impurity #1
do math note 35 10
; now do same for impurity #2
do math integral 4 register 1
do math memory 7 register 0
do math /
do math enter 100
do math *
set math comment Mole % Impurity #2
do math note 35 20
end

Displaying Relaxation Data and Calculating T1 and T2

(Not available in Nuts Lite)
The process of displaying and analyzing T1 or T2 data involves multiple steps. The FIDs, which should
have the same filename with sequential extensions, must first be transformed and phased. To make use
of all the tools provided within NUTS for viewing and processing a series of data, the series of spectra
must be written into a 2D file, a quick and simple process of executing the following Link:
GA SC IN (if the files have been translated; otherwise, use

IM SC IN )

(get dataset A, save as dataset C (Dataset C is used as the designation for a 2D dataset), increment and
loop).
When this Link is executed, a File Open dialog box is displayed and the user must supply the file name of
the first of the series of 1D files. Then, a Save As dialog box is displayed, and the user must supply a
name for the 2D file being created. The IN command increments the file extension for the 1D file being
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read, loops to the beginning and continues until no more files are found. On completion of this process,
the user must read in the newly created 2D file using GA or the File/Open menu option. The data can
then be viewed either one at a time (with VW) or as a stacked plot (with SP). These features are
available in NUTS-1D.
Note, it is worth manually checking each spectrum in the dataset for good phasing and baselines before
calculating relaxation data. (However, one can create a Link to automate the phasing and baseline
correction of the spectra as well.) Creating a relaxation plot of integral vs. time is a two-step process.
First the integrals must be measured, then the values displayed as a function of time. (The time values
are saved in a variable delay list and can be viewed and/or edited by typing D1. Be sure the time values
are correctly entered in this list before attempting to calculate relaxation data.) To measure the integrals
of a chosen peak, the user first selects a peak using Zoom to expand the spectrum so that only the peak of
interest is displayed (the narrower the chosen region, the better). Exit the Zoom subroutine using <Enter>. Type GR (or choose Get Relaxation data from the Tools menu). NUTS measures the integral (or,
optionally, the peak height) of the displayed region for each spectrum in the data set. Again, the baseline
(for each spectrum) in the expanded region must be good in order to obtain a realistic value for the
integral.
To display the plot of integral vs. time, type DR (or choose Data Reduction from the Tools menu). Each
data point is represented by a small square. An initial guess at an exponential curve is displayed, but this
does NOT represent a fit to the data. To perform a fit, type O.
As an alternative to using integral areas for calculating relaxation data, point or interpolated peak heights
may be used. These options are chosen within DR. Type F (or choose Fit Function from the Fit menu).
This menu box allows the selection of how the peak data is measured and the function to be fit. There are
three ways to measure the data; by area, point peak height or interpolated peak height. There are also
three functions to fit; T13IR (T1 data with a 3 parameter fit, does not assume perfect inversion), T1IR (T1
data with a 1 parameter fit, assumes perfect inversion) and T2 (T2 data). The default options are T13IR
using measured peak area. To change these options, type GR, DR, then F to choose selection type and fit
function. If peak selection type has been changed, then exit DR with <Enter> and repeat GR to remeasure the relaxation data with the new selection type. Enter DR again and type O for optimization.
The equations used for the fits are provided in NUTS Help under DR, and at http://www.acornnmr.com/
Nutshelp.
NUTS displays the curve determined by fitting the above equation to the data points. For T1 data, it displays
the values for T1, W (the percent inversion), and the value of the integral for infinite delay time. For T2 data, it
displays T2 and the value of the integral for infinite delay time. If the integral for the longest delay value is set to
100, this will be given as a percentage; otherwise, it is in the absolute integral units internal to the program. The
plot can be printed by selecting Print from the File menu. The whole process is repeated for each peak of
interest. A table of time and integral values can be copied to the windows clipboard by typing T (or
choosing Edit/Data to Clipboard), or put on the screen with S (equivalent to Ctrl-B).
As an alternative to having NUTS automatically calculate the integrals which will be fit to calculate T1
or T2, NUTS provides the option of reading in a text file which contains values of time vs. integral. This
is done with the RR (Read Relaxation) command or from the Tools menu. See Help on RR for details on
the format of the data file.
A sample set of T 1 data ( 13 C spectra of sucrose) is available at http://www.acornnmr.com/
sample_data_files.htm
For more detailed information, search NUTS Help or see section on relaxation at http://
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www.acornnmr.com/NutsHelp.

2D Processing
(not available in Nuts Lite or NUTS 1D)
2D data sets are most easily processed by executing a single command which runs a previously designed
and stored macro. 2D data sets can be processed manually one command at a time, but this is more
complicated. However, the user should have a basic understanding of the commands in the macros
because some parameters vary from experiment to experiment or with different spectrometers.
A macro is simply an ASCII text file which contains a series of commands or Links (strings of commands) which are applied automatically without user intervention (except to enter filenames or similarly prompted information). As a starting point, macros have been supplied with NUTS which perform the
basic types of 2D processing (magnitude, TPPI and hypercomplex). The macros supplied have comments
and, combined with the explanation below, should contain sufficient information for use.
An example of a macro which is provided with NUTS is called mag_cosy.mac and is given below. The
macro commands are in bold text. Explanations are in italics. Please note, all rules discussed in the
section on macros apply.
NUTSMacro for magnitude COSY

A macro always begins with NUTSMacro on the first line.

;macro prompts for name of data

A semicolon (;) indicates a comment, NUTS ignores this line.

ask FileA
ga

This macro prompts the user for the input (FileA) filename.
It now gets this file (FileA).

set filec ft1.2d

Designates the temporary filename for the transformed spectrum (output = FileC). FileC always
refers to 2D file. If ft1.2d exists, it will be overwritten without asking for confirmation.

set sl 1

Moves to the first slice of the 2D spectrum.

ga bc ms ft sc in

This is the first Link in the macro. Commands are: get FileA, baseline correct, multiply by sine
function, Fourier transform, save to FileC (ft1.2d above), and increment to the next slice. It repeats
until there are no more slices

set FileA ft1.2d
set filec td.2d
;transpose data

Now, for transposing the data, it sets the processed data created in the previous link, ft1.2d, to
FileA, as input for transposing (turning dataset by 90 degrees). It designates the transposed 2D
spectrum as td.2d (output).

set sl 1
td

Moves to the first slice of the first dimension.
Transposes the data (turns the data set by 90 degrees).

set FileA td.2d
set filec ft2.2d

Once again, switching what is input and what is output. FileA is now the transposed data set td.2d.
FileC (the transformed 2D dataset) is now ft2.2d.

set sl 1

Moves to the first slice.
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ga ms zf ft sr mc bc sc in

This is the second Link in the macro. Commands are: get FileA, multiply by sine function, zero fill,
Fourier transform, spectrum reverse (This is not always necessary and is dependent on the spectrometer in use), magnitude calculation (all peaks positive), baseline correct, save to FileC, and
increment to the next slice and repeat.

set FileA ft2.2d

Now sets final spectrum to FileA for displaying.

ga

Gets FileA

set sl 1

Moves to the first slice.

ss
end

Sets the automatic scaling factor which scales the spectrum in relation to the tallest positive and
negative peaks in the spectrum. Should be done before attempting to display a 2D spectrum.
All macros must have end on the last line.

This example is appropriate for a magnitude (not phase sensitive) experiment. Some modification is
required to process phase sensitive data, which can be either TPPI or hypercomplex (method of States,
et al.). Macros are provided which can transform these types of data as well, and are named tppi_2d.mac
and States2d.mac. Search for Help on TPPI or States and see sample macros at http://
www.acornnmr.com/NutsHelp/sample_macros.htm
To execute a macro, such as the one above, simply type RU (or choose Run macro from the File menu).
In general, a macro should prompt for the file name, and therefore the user does not need to read in the
2D data set before typing RU. However, it never hurts to use GA to read the dataset in before executing
the macro.
Also, the user needs to be aware the command GA (open file A) when applied to a 2D file behaves
slightly differently in macros or Links from when it is entered directly. The difference lies in whether
NUTS reads just a slice of the 2D data or reads both the slice and the data header. While in a Link
(either by itself or within a macro), NUTS reads the data header only once, for the first slice. This
makes reading subsequent slices faster. When GA is used to read a 2D file in a Link, NUTS assumes the
user loaded the first slice manually (with GA) immediately before executing the Link (which reads in the
file header and all is well). If the same Link is embedded in a macro, NUTS can be forced to read the
file header by inserting the following line just before the line containing the Link:
Set SL 1
The take-home message is, in macros ALWAYS set SL to 1 (one) before a Link in which GA will operate
on a 2D file. When executing a Link not in a macro, ALWAYS do a GA on the starting file just before
executing the Link.
The following 2D display commands can be accessed from the 2D Processing menu or entered from the
keyboard.
2D Display Commands Include (Commands available from menus):
SS: (set 2D scale) Recommended before displaying 2D spectrum. Sets scale of spectrum in relation
to the tallest peaks (positive and negative) in the spectrum. This is used to set contour levels
starting at the level specified by MH. See Help on NUTS.
VW: (view 2D slices) Steps through slices of a 2D dataset. Set starting slice with SL.
TD: (transpose data) Swaps the first and second dimensions of a 2D dataset and their associated
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parameters. Basically, rotates dataset by 90 degrees.
PJ: (project 2D file) Calculates the projection of the current 2D dataset along the horizontal axis.
The rows which are included in the calculation of the projection are those displayed currently or
most recently with IP or CP. (The projection calculation includes all points in each chosen row.)
IP: (intensity plot) Plots an intensity plot of the 2D spectrum. Not as nice as a contour plot, but
faster.
CP: (contour plot) Plots a contour plot of the 2D spectrum.
SL: (get slice) Allows selection of a slice of a 2D spectrum.
SY: (symmetrize) Symmetrizes the data. Note, this requires time and disk space.
While displaying either an intensity plot or a contour plot, typing C switches to contour plot and I
switches to an intensity plot (single-letter commands with no Enter). This can cause some confusion if
the user attempts to enter a 2-letter command which contains either a C or an I. The display routine will
grab a C or an I as soon as it is typed and draw the corresponding display, even though the user may
have intended something completely different. 2-letter commands which do not include C or I work as
they do at the Nuts base level.
The contour (or intensity) plot can be resized by setting the size of margins, from the Edit/Edit Display
Parameters menu choice. Contour levels and colors are set in the NUTS.ini file, which can be edited
with any text editor. They can also be set within NUTS using the LV and CR commands, respectively.
Projections or high resolution 1D spectra can be placed along each of the 4 edges of a 2D plot from the
Borders menu while displaying an intensity or contour plot. They will be aligned by chemical shift. The
vertical scale of these projections can be changed by choosing Edit Display Parameters from the Edit
menu.
For a description of 2D display operations, use NUTS Help and Search for IP or section on 2D at http:/
/www.acornnmr.com/NutsHelp.

Arrayed Mode (included in NUTS Pro version only)
This is an extra-cost option for NUTS-2D and requires a computer with more memory. The entire 2D
data set is placed into memory, resulting in much faster 2D processing (a factor of ~12 in our tests, more
on the Mac). The normal way of processing 2D data is by looping through a command string, applying
the commands to each slice in turn. With the Arrayed Mode, each command operates on the entire 2D
data set; i.e., typing FT one time transforms the all slices.
The AR command (not yet in menus) is a toggle, and turns on/off arrayed mode. In a macro, you can also
use
Set array_on
Set array_off
First, (before entering Arrayed Mode) open the FID and determine window function and phasing parameters on the first slice. Then use AR to enter Arrayed Mode. Process in the first dimension with
commands such as
GA BC MS FT PS
These commands can be typed directly, or can be executed as a Link or a Macro. Note that there is no SC
command and no IN command. Next, execute TD to rotate the matrix in preparation for processing in the
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second dimension. Execute an appropriate series of commands, such as
MS FT MC
If it is necessary to examine slices in the second dimension before processing in order to determine
window function and/or phasing parameters, you must save the data and exit the Arrayed Mode in order
to operate on single slices. Typing AR exits Arrayed Mode. You will be asked if you want to save the
data before exiting Arrayed Mode, which you should do. After processing parameters are determined,
re-enter AR mode, open the saved data, and proceed to process the second dimension. Note that you
cannot go back to the previous step, as the data is not saved at each step, as is the case when processing
in the regular mode. Of course, the original data is unchanged, so it is always possible to go back and
start over.
After processing the second dimension, you can execute another TD command to view the data with the
first dimension displayed horizontally.
Sample macros for processing 2D data using Arrayed Mode can be found at
http://www.acornnmr.com/NutsHelp/arrayed_mode.htm.
Automatic peak picking of 2D data is now available in the Arrayed Mode. While in Arrayed Mode, with an
intensity plot displayed, enter the DP routine and type A to perform automatic peak picking.

Searchable Archive
(not available in Nuts Lite)

This NUTS tool is used to create and search an archive file containing information about a collection of
Nuts spectra. The file is a text file consisting of several fields, identified by keywords.
The information placed into the archive file is taken from the tailer of each file in a directory or folder.
When a spectrum is processed with Nuts and then saved, several pieces of information are automatically
saved in the file tailer. This can include:
1. a list of peaks defined within the DP subroutine
2. a list of integral regions defined via automatic integration (AI) or in the integration subroutine (ID)
3. a pointer to a metafile (or PICT file on the Mac) containing a molecular structure, imported into the
MO routine
4. items such as multiple names, molecular formula and nucleus which are input via the IF command
Creating the archive file
Creation of an archive file involves first processing each spectrum and saving the processed data, all in
the same directory or folder. The archive file is created within Nuts using the Database Make (DM) command, which reads the tailers of all files in the chosen directory and enters the information into a text file with
appropriate keywords.
Windows version  The DM command takes all the NUTS files in the selected directory and constructs a text
file from information saved in each files tailer. When the DM command is executed, a File Open dialog box is
displayed. The user selects any file in the directory containing the Nuts data. All files to be included in
the database must reside in that directory. The archive file has the default name _master.ndb, which can
be renamed only after it is created. This file can then be searched from within Nuts using the DS
command. This file includes pointers to the NUTS spectra, so that files matching search criteria can be
loaded into Nuts.
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Macintosh version  Due to limitations of the Macintosh operating system and the Microsoft NT cross
compiler for the Macintosh, the DM command does not operate in exactly the same way as the Windows version. The problem is that the Macintosh is not capable of creating a list of files in a folder in an
automated way, which is used to create the searchable file. Instead, the user must first create a text file
consisting of a list of the NUTS file names, all saved in one folder, from which Nuts will construct the
database. When the DM command is executed, a File Open dialog box is displayed. The user selects
this text file, and then the command operates as for the Windows version. The default name for the
archive file created by DM is [space]master.ndb (so that it will be displayed at the top of the list of files
in that folder).
Searching the archive file
The archive file created with DM could be searched with any search tool, but is most easily searched from
within Nuts using the Database Search (DS) command. A dialog box is displayed allowing search
criteria to be entered in several fields. With the exception of the chemical shifts, all searches are substring searches. For chemical shifts, a value is entered as well as a range. When an entry is made in the
Name field, the search operation looks for matches in any of the 3 Name fields defined in the IF routine.
Entries can be made in more than one field, which causes the search to find entries which meet all
specified criteria (logical AND). Multiple entries can be made in the Name field, separated by a space,
to search for a name containing multiple sub-strings. For example, entering methyl phenyl would
search for occurrence of both methyl and phenyl in the name fields, and select only those containing both.
After the Search button is clicked, a box displays the number of hits found, and clicking on OK displays
information about each file, in turn, that matched the search criteria. When the desired file is located,
the corresponding spectrum is loaded into Nuts by clicking on the Load button. The information from
the file tailer is automatically read, and peak labels, integrals and structures (if any) are displayed. To
select another file from that search, use the View Search (VS) command to return to the list of files
created by DS, without performing the search again.. To perform another search, enter the DS command again.
File Tailers
A new feature of NUTS (versions greater than 5.09) allows a peak list, integral list and some additional
data to be saved as a file tailer, appended to the end of the data file. A flag found in the File menu
determines whether or not information is automatically read from the tailer when a file is opened.
The NUTS commands which pertain to this are:
TA  Read all information from file tailer.
TS  Save tailer information to a separate ASCII file. An example is shown below.
IF  Enter other information to be saved in tailer.
If integral regions have been defined at the time a file is saved, they are saved in the file tailer. Similarly, if peaks have been selected in the DP subroutine, that peak list is saved. The comment line (CO)
and the path to the file are also saved in the tailer. The additional information which can be saved,
using the IF command, includes 3 lines of text, a molecular formula and nucleus type.
There is a flag in the File menu which can be set to automatically read the file tailer when a file is
opened. From within the Integration subroutine, integral regions can be recalled from the tailer from the
Edit menu, or using the keyboard command R.
One note of caution: Because integral and peak lists defined in DP are not cleared when a new data set
is opened, it is possible to save irrelevant information in the file tailer of that new file when it is
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subsequently saved. Also, some peaks or integrals previously defined may fall outside the spectral
limits of the second file. In this case, the invalid peaks are reset to the closest valid data point, and
invalid integral regions are not displayed.
A sample of a file Tailer, as saved using TS, is:
INFORMATION
Name1=data from Sam
Name2=stuff
Name3=CDCl3
Comment=Sample # K-47-B
Formula=C6H10N
Nucleus=H1
Path=D:\NUTS\DATA\sam\$DATA
END_INFORMATION
PEAKLIST
LINE
HZ
PPM
INTENSITY
1
2307.23
7.687
120753536
2
2097.74
6.988
111956936
END_PEAKLIST
INTEGRALS
REL_VALUE = 1.589616e-009
START_PT START_HZ END_PT END_HZ
6394
8.432
6514
8.281
6681
8.072
6814
7.905
7243
7.366
7433
7.127
END_INTEGRALS
END_TAILER

REL INT
10.149
9.410

XOFFSET
0.000
0.000

YOFFSET
0.000
0.000

HorV
V
V

LABEL
4
5

VALUE LABEL POSITION
0.986642
1
1.000000
1
6.768002
1

Alphabetical Command List
Commands marked with * not available in Nuts Lite.
For complete description of each command, see http://www.acornnmr.com/NutsHelp.
21*

To One. Similar to 2L. Convert current spectrum into a line with a value of 1.

2A

Number of points to average when applying BF and FR baseline corrections

2F

Turn off 2-letter command mode.

2L

Convert current spectrum into a line with a DC offset from zero.

2N

Turn on 2-letter command mode.

2S

Performs 2-point smoothing for noise suppression.

3S

Performs 3-point smoothing for noise suppression.

Alt-C Copy current spectrum to Windows clipboard as Metafile for pasting into other programs.
Alt-E Copy current spectrum to Windows clipboard as Enhanced Metafile for pasting into other programs.
Alt-P Copy current spectrum to Windows clipboard as Metafile, using printer device context, for
pasting into other programs.
Alt-Ctrl-C Copy current spectrum to a file as a Standard Windows Metafile.
Alt-Ctrl-E Copy current spectrum to a file as a Enhanced Windows Metafile.
Alt-Ctrl-L Copy current spectrum to a file as a Placeable Windows Metafile.
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Alt-Ctrl-P Copy current spectrum to a file as a Enhanced Windows Metafile using printer device
context.
Ctrl-A Toggle axis type among the choices: None, Hertz, PPM and Points.
Ctrl-B Toggle on/off display of clipboard text (Same as CB command).
Ctrl-C Copy current spectrum to Windows clipboard as bitmap for pasting into other programs.
Ctrl-D Toggle display between data points only and data points connected with lines.
Ctrl-E Change to expanded display with previously defined limits.
Ctrl-F Change to full display.
Ctrl-I

Toggle display of integrals on and off.

Ctrl-L Create a special Notes entry containing acquisition and processing parameters.
Ctrl-N Toggle on/off display of all Notes (defined in the NO subroutine).
Ctrl-P Toggle peak labels on and off (after selection in DP routine).
A0 - A9 Automatic execution of corresponding linked command string.
AC

Amplitude Change. Enter vertical scaling factor.

AD

Add DC offset to data. This changes the data, not just the display.

AF

Turn off display of integrals.

AI

Automatic integration.

AL

Load current spectrum into Add/Subtract buffer.

AM

Adjust parameters for spectrum in Add/Subtract buffer.

AN

Turn on display of integrals.

AO

All off. Exits from all subroutines.

AP

Automatic Phasing. Adjustment of zero-and first-order phase.

AR*

Enter Arrayed Mode for 2D processing (NUTS-Pro only).

AS*

Add/Subtract spectra. Enters subroutine for manipulating 2 spectra.

B1

Load Buffer 1.

B2

Load Buffer 2.

B+

Add Buffers 1 & 2; sum becomes current data set.

B-

Subtract Buffers 1 & 2; difference becomes current data set.

BC

Baseline Correct. Removes DC offset from FID. Removes DC offset and tilt from spectrum.

BD*

Convolution Buffer to Data. Transfers contents of convolution buffer to current dataset.

BF

Baseline Flatten. Removes DC offset and linear tilt within ZO frequency limits.

BS

Byte Swap. Useful in troubleshooting data importing.

BT

Bruker Transform. Performs a forward transform of Bruker interleaved data set.

BU

Enter Buffers subroutine.

BV

Byte swap to VAX byte order.

BW

Set all colors to black

BZ

Baseline Zero. Zeros the expanded Zoom region.
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C1-C4 Combine Data (in Arrayed Mode only)
CA*

Apply convolution function calculated with CF.

CC

Close file C which has been opened for writing data into.

CD

Color display

CF*

Calculate convolution function to correct distorted lineshapes.

CH

Chloroform lineshape display.

CL

Display lines on chloroform lineshape at .55% and .11%.

CO

Comment (eg., sample name or number).

CP*

Contour Plot of 2D data set.

CR

Set contour level colors.

CS

Clear scaling previously set with FS.

CT

Complex Transform. Performs a forward complex Fourier transform of the current data set.

CV*

View convolution function calculated with CF.

CX

Allows setting of some parameters for data importing.

D1

Display list of variable delay values from an arrayed experiment.

D2

Decimate data by 2 by discarding every other point.

DA

Date of data acquisition.

DB*

Data to convolution Buffer. Transfers data to convolution. buffer for creation of customized
apodization functions.

DC

DC offset for display. Allows adjustment of spectrum vertical offset.

DD*

Dual Display.

DE

Delete file. Brings up a dialog box to select file.

DH*

Digital High-pass filter.

DL*

Digital Low-pass filter.

DM* Database Make. Build searchable archive file from Nuts data files.
DP*

Define Peaks. Enter routine for manual peak picking using the mouse.

DR*

Display Relaxation data for currently displayed peak and calculate T .

DS*

Search Database created with DM.

E1, E2, E3, E4 & E5

1

Export spectrum as ASCII file; 5 choices of format.

EJ & E6 Export data in JCAMP-DX format.
EF

Email file (Win only)

EM

Exponential Multiplication of the FID.

EX

Name of pulse experiment used to acquire data.

EZ

Enter limits to define zoom region

F1, F2

Spectrometer frequencies in the first and second dimensions.

FA

Select font parameters for axis.

FB*

Fit Baseline with polynomial.
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FC

Select font parameters for clipboard display using Ctrl-B.

FH

Select font parameters for horizontal peak labels.

FI

Select font parameters for integral labels.

FL

Select font parameters for command line.

FM

Select font parameters for parameters printed on the bottom of plots.

FN

File New. Used to set parameters for spectral simulation.

FP

FID Play. Plays FID to the computers speakers (Windows only)

FR

Flatten baseline of Zoom region

FS

Fix Scaling so a series of spectra can be directly compared.

FT

Fourier Transform. Does a forward Fourier Transform of the current data set.

FV

Select font parameters for vertical peak labels.

GA

Get data set A. Opens the dialog box for loading a file.

GB

Get data set B. Opens the dialog box for loading a file.

GC

Get data set C. Opens the dialog box for loading a file.

GF

Gaussian Factor. Used with Lorentzian/Gaussian resolution enhancement (LG).

GM

Gaussian Multiplication for signal-to-noise enhancement.

GR*

Get Relaxation data for currently displayed peak in a T1 experiment.

GS

Get Sample. (Virtual Spectrometer command.)

HS

Help Swap. Switch between HTML and WinHelp style help (Win only).

HT*

Hilbert Transform. Creates a complex FID from reals-only spectrum.

IA

Increment counter for file A. Used in processing hypercomplex 2D data.

ID

Integral Display.

IE

Increment file extension. Used in Links for processing a series of spectra.

IF

Tailer Information input, to be saved in files tailer.

IG

Incrementally shifted Gaussina window function.

II

Invert Imaginaries. Negates all points in the imaginaries.

IL

Integral List. Transfers sub-integral list to the clipboard.

IM

Import file. Performs data format translation and loads translated file.

IN

INcrement slice number. Used in processing a series of spectra with a linked command list.

IP*

Intensity Plot of a 2D data set.

IS*

Inset Plots subroutine.

IT

Inverse Transform. Performs an inverse complex transform of the current data set.

IV

InValidate the data. Causes the data to be recalculated and repainted.

JJ

13

C chemical shift search

L0-L9 Link #. Displays the current command lists.
LB

Line broadening used with EM, GM, LG and TF commands.

LF*

Enter line fitting subroutine.
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LG

Execute Lorentzian/Gaussian resolution enhancement.

LI

Links. Allows definition of linked command sequences.

LN*

Linear prediction.

LO

Look at file format. Useful for hacking apart data file formats.

LP

List spectrum parameters to clipboard for pasting into other applications.

LS

Left Shift data one point.

LV

Set contour level multipliers.

LZ

Jump to Last Zoomed region.

M2

Computes the power spectrum of the current data (similar to MC).

MA

Math calculations

MC

Magnitude Calculation. Computes the magnitude spectrum of the current data.

MF

Make Full. Adjust vertical display scale.

MH

Minimum Height for peak picking as a percent of the tallest peak.

MO

Meta Object. Allows creation and manipulation of inset plots within a spectrum.

MS

Multiply Sine. Applies sine window function. Phase shift set with S#.

NA

Number of Acquisitions. Parameter will be saved with the file and printed on plots.

NB

Toggle on/off Nuts Bug flag to enable status messages.

NO*

Notes subroutine, for text annotation.

NS*

NMR Simulation. Calculates spectrum from shifts & couplings input by user.

O1, O2 Spectrum offsets in the first and second dimensions.
OC

Open file C. Used in processing 2D data.

PA

Phase A. Input zero-order phase correction to be applied with PC.

PB

Phase B. Input first-order phase correction to be applied with PC.

PC

Phase Correction. Adjusts the phase of spectrum by the values in PA and PB.

PD

Pulse delay used in data acquisition. For information only.

PE

Phasing Expanded. Mouse phasing routine using 2 expanded regions.

PF

Turns off display of peak labels created with PP or in the Define Peaks (DP) subroutine.

PH

Phasing using mouse. Left & right mouse buttons control A and B phase parameters.

PI

Incremented phase. Used in some solids 2D experiments.

PJ*

Calculate projection of the current 2D data set.

PL

Plot the currently displayed spectrum.

PN

Turns on display of peak labels created with PP or in the Define Peaks (DP) subroutine.

PP

Peak Picking. Peaks are indicated by vertical lines on the display & peak list placed in Clipboard.

PR

Position reference.

PS

Phase Same. Applies previously determined phase correction to current spectrum.

PW

Pulse width used in data acquisition. For information only.
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QA

Quick Phase, zero-order only. Applies first approximation to zero-order phase.

QB

Quick polynomial Baseline correction. See description of FB.

QD

Quick Display. Changes the display mode to a faster compressed display.

QP

Quick Phase. Applies first approximation of phasing parameters.

R0-R9 Register set of 1D spectra to align chemical shifts.
RD

Rotate Data. Required for Bruker digitally filtered data.

RE*

Resonance Elimination. For subtracting single frequency from FID.

RI

Exchange Real & Imaginary data.

RL

Read License. Reads a special ASCII file and converts it to binary license.nmr file.

RM

RMS noise multiple. Used by the PP command in selecting peaks.

RO

Square Root. Takes square root of the data points of both reals and imaginaries.

RR*

Read Relaxation data file. Time vs. peak area list is read from a file.

RS

Right Shift data one point.

RT

Real Transform. Performs a Real FT of the current data set.

S@

Set number of points to be deleted with SHrink command.

S#

Enter phase for shifted sine multiplication.

S0

Set vertical scaling scroll bar to zero.

S2*

Save 2D dataset. Can be saved under a new file name or updated under current name.

SA

Save dataset A. Saves the current data set under the File A name.

SB

Save dataset B. Saves the current data set allowing the entry of a different file name.

SC

Save dataset C. Used in processing 2D data.

SD

Slow Display. Changes the display mode to displaying every point.

SF

Spectrometer Frequency.

SG

Shifted Gaussian window function.

SH

SHrink data. Reduces the 1D data size by half.

SL*

SLice. Select which slice of a 2D data set will be available for processing.

SM

Enter Shimming simulation routine

SN

Signal to Noise. Calculates S/N of the tallest peak in the displayed region.

SP*

Stacked Plot. Spectra must be in 2D file format.

SR

Spectrum Reverse.

SS*

Set 2D data Scale. Execute before displaying 2D data with IP.

ST

Store data set constructed from data tagged with TR and TI.

SW

Sweep width in Hz.

SY*

Symmetrize 2D data set.

SZ

Set frequency to zero.

T+

Add file tailer

T1

Set first point for trapezoidal multiplication.
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T2

Set second point for trapeziodal multiplication.

TA

Tailer All. Reads integrals and peak list previously saved in files tailer.

TC

Set calculation type. Macintosh 68K version only.

TD*

Transpose data. Swaps the first and second dimension of a 2D data set.

TF

Execute TRAF (Traficante) resolution enhancement.

TI

Tag Imaginary part of data for later storage.

TM

Trapezoidal Multiplication using parameters T1 and T2.

TP

Total Phase correction applied.

TR

Tag Real part of data for later storage.

TS

Tailer Save. Saves information from files tailer to ASCII text file.

UD

Update display.

UF

Turn off UnDo mode.

UH

Update header for 2D files.

UN

Turn on UnDo mode.

US

User name.

VP

Virtual parameters for use with Virtual Spectrometer

VS*

View results of database search performed with DS.

VW* View slices of 2D data set or series of 1D data.
W1, W2 Sweep width in the first and second dimensions.
WC

Which color, allows choice of color for spectrum.

WP

Which Path. Displays the paths of the current data and import directories.

WS

Window Size. Allows setting of NUTS window in pixels

WV

Window View, for adjusting apodization functions.

X0-X9 Extract one of 10 previously defined spectral regions
XC*

Clear spectra which have been extracted for use as projections on 2D plot.

XL

eXtract a Line from a spectrum, centering it and deleting spectrum outside chosen

XT

eXTract spectral region.

XX

Exit NUTS.

region.

Y0-Y9 Sum block-averaged spectra with peak registration.
Z0-Z9 Display one of 10 previously defined spectral regions
ZE

ZEro data set. All data points in the currently displayed data set are set to zero.

ZF

Zero Fill. Doubles the 1D data size by adding zeros to the end of the current dataset.

ZG

Zero & Go. (Virtual Spectrometer command)

ZI

Zero Imaginary part of FID or spectrum.

ZL

Zero peak List. Clears the list of peaks picked with PP.

ZN*

Zero all Negative. Zeros negative data points of both reals and imaginaries.
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ZO

Zoom Routine. Enters the Zoom routine, allowing expansion of spectrum using the mouse.

ZP

Zero Phase. Sets both zero- and first-order phases to zero.

ZR

Zero Real part of FID or spectrum.

ZZ

Auto-importing of file as specified in Nuts.ini file.

Data Translation

Some users may wonder why the data formats need to be translated. The first reason is that every NMR
vendor has a different format for the NMR data file. In its most simple form, this usually consists of
one disk file which has two main parts: the header and the data. The NMR data file header is where spectral
and instrument parameters are stored and the NMR data is in the rest of the file. Every vendor, and sometimes
different models of NMR instruments from the same vendor, have a different header configuration with
the spectral parameters stored in different ways and locations. Also, the header is sometimes altered in
the process of transferring the data from the spectrometer. An additional complication is the NMR
vendors use different computers. Older Nicolet/GE NMR instruments use 1080, 1180 or 1280 computers with 20 bit integer words. Older Bruker NMR systems use Aspect 2000 or 3000 computers with 24
bit integer words. The newer GE, Bruker and Varian instruments use UNIX computers like SUNs and
Silicon Graphics, which use either integer or floating point words usually 32 bits (or four bytes in
length). NUTS uses 32 bit floating point words. Finally, the byte order for the words with the UNIX
computers is different from the byte order in the PC environment. These examples illustrate the complexity of converting many different data formats to that used by the NUTS program. To import data,
NUTS looks for various characteristic features to identify the files origin and then applies the appropriate translation. These identifying features are described in the Imports.txt file and in the NUTS on-line
Help under data translation. New file translations are being added to NUTS as sample files and format
information become available. If a file type is not currently supported or if data is not imported correctly, contact Acorn NMR.
NMR Data Conversion Types
The types of files which NUTS can autodetect and convert are:
Varian VXR-5000 and Unity and Inova files.
Nicolet 1180 and 1280 Dexter NT spectrometer data files.
Nicolet/GE TMON data files from NT, QE and GN spectrometers.
GE Omega spectrometer files exported with the GE Export command.
Bruker Aspect 3000 data files, X-32, UNIX and XWin-NMR files, including AVANCE series data files.
JEOL *.GXD/*.GXP, EX, FX, LAMBDA, Alpha files and files exported as Jeol Generic.
Chemagnetics Spinsight files
Tecmag MacFID and MacNMR files.
WinNMR files
Grams-386 files
JCAMP files
ATI ASCII and binary.
SMIS files.
Analogic files.
PCNMR files in Lybrics format.
ASCII files.
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GE Medical Systems files
And a few others. New formats from major spectrometer manufacturers will be added as sample files
and format information becomes available.
Varian data files from XL, Gemini and older VXR systems can be translated with a utility program
called V_Helper, written by Steve Silber at Texas A&M University. A version of V_Helper which
converts Varian data to the NUTS format can be obtained through Acorn NMR for $25.
As the conversion process takes place, the original NMR data file is read only and is left unmodified.
A new file is created by the conversion process and will have the same name and extension as the
original file with the exception that a dollar sign, $ will be appended to the beginning of the name. For
example, if the original file name was file.001 the converted file name will be $file.001.

Technical Support

Acorn NMRs technical support service is available to NUTS users free during the 90 days warranty period
after initial purchase and for an annual fee of 15% of purchase price thereafter.
Technical support is available by phone from Acorn NMR during normal business hours (9:00 AM to 5:00 PM
Monday through Friday except holidays). The preferred method of technical support is by E-mail since
telephone tag is eliminated and time and conditions are better for a careful examination of the problem. In
addition, sample files can be exchanged via ftp.
Telephone support is available at

(925) 456-1020

or

(925) 456-1024

FAX

Email support is available via the Internet at: support@acornnmr.com
Notice of New Features
Acorn NMR maintains a World Wide Web site, on which can be found the latest Whats New, other
current information, sample macros, and the latest version of Nuts, along with installation instructions.
The URL is
http://www.acornnmr.com
An updated version of Nuts can also be obtained by anonymous FTP to ftp.acornnmr.com
Upgrades
Owners of NUTS-1D and NUTS-2D with active technical support service from Acorn NMR (90 warranty period or by subscription thereafter) can download a new copy of Nuts as often as desired. To do
this, download a demo copy. Your license file will activate this to be a fully functional copy, as long
as the compile date of the Nuts version falls within the support date of the users license. If your support
period has expired, the new version will function as a demo copy, although the older version will
continue to work forever. Support is not available for NUTS Lite.

Acorn NMR Software License Agreement and Support Policy

Nuts is licensed for use on one system at a time. You may have as many copies of NUTS on as many PCs
as desired as long as only one copy of NUTS can be used at the same time. It is the licencees responsibility to regulate this process.
A new method of licensing NUTS has been developed. It was designed to allow NUTS customers to
update their copies of NUTS as desired to take advantage of new features and bug corrections as long
as they are under a NUTS support plan. The new licensing method works as below:
1.

If a separate file called LICENSE.NMR is present in the same directory as the NUTS program,
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then when NUTS is started the program checks this encrypted file for the licensing information and
authorization level. If this file is missing or becomes corrupted, the NUTS program will operate as
a demo copy. Save a backup copy of LICENSE.NMR.
2.

The LICENSE.NMR file contains the current licensee and organization. This is the only copy
protection for the NUTS program.

3.

When a new NUTS copy is downloaded and run with your LICENSE.NMR file present, NUTS
checks the LICENSE.NMR file for the last valid date of its support plan. This date is compared to
the date the new NUTS copy was prepared. As long as the NUTS programs date is within the
support period, the LICENSE.NMR file will be valid and the NUTS program will work. If not, the
new copy of NUTS will revert to operation as a demo copy. The LICENSE.NMR file can still be
used with the previous version of NUTS. For this reason, you should keep a backup copy of the
NUTS program when upgrading in case you need to return to the previous version.
Each sale of NUTS comes with 90 days of support. The LICENSE.NMR file contains this information.
Additional support can be purchased under one of the following plans:
1.

If you can obtain updates by FTP or WWW, the support is 15% of purchase price per year. You may
obtain as many new copies as desired during you support period.

2.

If you need to have updates shipped to you on a floppy, an additional shipping fee of $40 per year
will be charged, and you may request 4 updates per year, not to exceed once per quarter.

3.

If support has expired for your NUTS copy, it may be restored by paying the price for support from
the date support expired to the date support is to start plus the price of the support plan.
4. The program is to be installed per the directions in the users manual. The supplied program is not
copy protected, but is copyrighted. Immediate site and company-wide site licenses are available,
and discounts for multiple copies.
(Note that multiple copy discounts are not available for NUTS Lite.)

NUTS Lite includes basic 1D processing features, NUTS-1D includes also more advanced features
such as simulation, deconvolution, add/subtract and relaxation analysis. The 2D package allows basic
2D processing and includes all the 1D capabilities. NUTS-Pro includes all features plus advanced 2D
processing including Arrayed Mode. The software is supplied with 90 days of telephone and E-Mail
support. Multiple copy discounts for support are available if purchased together. Users with extended
support may download new copies as desired from ftp.acornnmr.com or http://www.acornnmr.com.
The Licensee assumes all responsibility for the selection of the program to achieve his/her intended
results, and for the installation, use and results obtained from the program. If the Licensee copies or
modifies the program in whole or part except as expressly provided for in this license, the license is
automatically terminated.
License
The Licensee may:
Use the program on a single machine and copy the program into any machine-readable or printed form
for backup or support of his/her use of the program on the single machine. The user is also authorized
to have the supplied program exist on as many different computer systems as desired as long as only
one licensed copy of the program is ever used at one time. If it is possible to have more than one copy
of the supplied program in use at a time, additional copies of the program should be purchased
Modify the program and/or merge it into another program for his/her use on the single machine. Any
portion of the program merged into another program will continue to be subject to the terms of this
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Agreement. The copyright notice must be reproduced and included on any copy, modification, or portion
merged into another program.
Transfer the program and license to another party if the other party agrees to accept the terms and
conditions of this Agreement. If the program is transferred, he/she must at the same time either transfer
all copies, whether in machine readable or printed form, to the same party or destroy any copies not
transferred; this includes all modifications and portions of the program merged into other programs.
Term
The license is effective on the date this agreement is accepted by the Licensee, and remains in effect
until terminated as indicated above or until the Licensee terminates it. If the license is terminated for
any reason, the Licensee agrees to destroy the program together with all copies, modifications, and
merged portions in any form.
Warranty disclaimer
The program is provided as is without warranty of any kind, either expressed or implied, including,
but not limited to the implied warranties of merchantability and fitness for a particular purpose. The
entire risk as to the quality and performance of the program is with the Licensee. Should the program
prove defective, the Licensee (and not Acorn NMR or its dealers) assumes the entire cost for all necessary repair or correction. Some states do not allow the exclusions of implied warranties, so the above
exclusion may not apply. This warranty gives the Licensee specific legal rights and the Licensee may
also have other rights which vary from state to state.
Acorn NMR does not warrant that the functions contained in the program will meet the Licensees
requirements or that the operation of the program will be uninterrupted or error free.
Limitation of remedies
In the event that the computer media on which the program is provided is defective in materials or
workmanship, the exclusive remedy is limited to its replacement, or a refund of the purchase price
therefore, by Acorn NMR in accordance with its applicable product return and replacement policies. In
no event will Acorn NMR or its dealers be Liable to the Licensee for any damages, including lost
profits, lost savings, or other incidental or consequential damages arising from the use or inability to use
the program (whether or not due to any defects therein) even if Acorn NMR or its dealers have been
advised of the possibility of such damages, or for any claim by any other party.(some states do not allow
the limitation or exclusion of liability for consequential damages so the above limitation may not apply.)
General terms
This Agreement can only be modified by a written agreement signed by the Licensee and Acorn NMR,
and changes from the terms and conditions of this Agreement made in any other manner will be of no
effect. If any portion of this Agreement shall be held invalid, illegal, or unenforceable, the validity,
legality, and enforceability of the remainder of the Agreement shall not in any way be affected or impaired thereby. This Agreement shall be governed by the laws of the State of California.
Acknowledgment
The Licensee acknowledges to have read this agreement, understand it, and agree to be bound by its
terms and conditions. The Licensee further agrees that it is the complete and exclusive statement of the
agreement between the Licensee and Acorn NMR which supersedes all proposals or prior agreements,
oral or written, and all other communications between the Licensee and Acorn NMR relating to the
subject matter of this agreement.
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